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Integration

To Do

Section Comment

Integration

Target

Test Case Comment

1 Verify C/C++ EPP Package RC1

1.1 Download EPP Package Download, extract and start EPP package EPP Package starts Pass
Verify that all tracing features and plug-ins are present and have the
1.2 Version of Tracing Features Go to Help -> About Eclipse -> Installion Details correct version (TMF, LTTng, CTF, GDBTrace) Pass
1.3 TMF presence Open Tracing perspective Tracing perspective opens Pass
1.4 LTTng presence Open LTTng Kernel perspective LTTng Kernel perspective Pass
1.5 GDB Tracepoint Analysis presence Open GDB Trace perspective GDB Tracepoint analysis perspective Pass
Go to Help -> Install New Software... -> Update site "Mars -
Mars Update Site http://download.eclipse.org/releases/maintenance" Verify that all LTTng Kernel, LTTng UST and GDB Trace are availab N/A update site wasn't available anymore at the time of testing

2 Verify C/C++ EPP Package RC2

Download, extract and start EPP package. Check the mailing list for the pac

2.1 Download EPP Package https://dev.eclipse.org/mailman/listinfo/epp-dev EPP Package starts Pass
Verify that all tracing features and plug-ins are present and have the
2.2 Version of Tracing Features Go to Help -> About Eclipse -> Installation Details correct version (TMF, LTTng, CTF, GDBTrace) Pass
2.3 TMF presence Open Tracing perspective Tracing perspective opens Pass
2.4 LTTng presence Open LTTng Kernel perspective LTTng Kernel perspective Pass
2.5 GDB Tracepoint Analysis presence Open GDB Trace perspective GDB Tracepoint analysis perspective Pass
Go to Help -> Install New Software... -> Use the testing update site "Mars -
2.6 Mars Update Site http://download.eclipse.org/releases/maintenance” Verify that all LTTng Kernel, LTTng UST and GDB Trace are availab Pass
3  Verify C/C++ EPP Package RC3
3.1 Download EPP Package Download, extract and start EPP package EPP Package starts Pass
Verify that all tracing features and plug-ins are present and have the
3.2 Version of Tracing Features Go to Help -> About Eclipse -> Installation Details correct version (TMF, LTTng, CTF, GDBTrace) Pass
3.3 TMF presence Open Tracing perspective Tracing perspective opens Pass
3.4 LTTng presence Open LTTng Kernel perspective LTTng Kernel perspective Pass
3.5 GDB Tracepoint Analysis presence Open GDB Trace perspective GDB Tracepoint analysis perspective Pass
Go to Help -> Install New Software... -> Use the testing update site "Mars -
3.6 Mars Update Site http://download.eclipse.org/releases/maintenance” Verify that all LTTng Kernel, LTTng UST and GDB Trace are availab Pass
4  Verify C/C++ EPP Package RC4
4.1 Download EPP Package Download, extract and start EPP package EPP Package starts Pass

Verify that all tracing features and plug-ins are present and have the
correct version (TMF, LTTng Control, LTTng Kernel, LTTng UST,

4.2 Version of Tracing Features Go to Help -> About Eclipse -> Installation Details CTF, GDBTrace) Pass

4.3  TMF presence Open Tracing perspective Tracing perspective opens Pass

4.4 L TTng presence Open LTTng Kernel perspective LTTng Kernel perspective Pass

4.5 GDB Tracepoint Analysis presence Open GDB Trace perspective GDB Tracepoint analysis perspective Pass
Go to Help -> Install New Software... -> Use the testing update site "Mars -

4.6  Mars Update Site http://download.eclipse.org/releases/maintenance” Verify that all LTTng Kernel, LTTng UST and GDB Trace are availab Pass

5 Verify Update Site

Download Eclipse standard and install LTTng Kernel, LTTng UST,
GDBTrace and PCAP Network Analysis from main Mars testing Update site

5.1  Mars Update Site "Mars - http://download.eclipse.org/releases/maintenance” Verify that installation was successful Pass
Download Eclipse standard and install LTTng Kernel, LTTng Control,
LTTng UST, GDBTrace and PCAP Network Analysis from the Linux Tools
Update site

5.2 Trace Compass Update Site http://download.eclipse.org/tracecompass/mars/milestones Verify that installation was successful Pass



5.3

5.4

55

6.1

6.2

Upgrade using Mars Update Site

gpgrade using Trace Compass Update
ite

Upragde from previous EPP

Verify Update Site

Trace Compass update site

Upgrade using Trace Compass
update site

Integration

Download Eclipse standard from Mars SRO and install LTTng, LTTng
Kernel, GDBTrace and PCAP Network Analysis from main Mars Update
site.

http://download.eclipse.org/releases/mars

Try to update the installation using the testing Mars update site.

Mars - http://download.eclipse.org/releases/maintenance

Download Eclipse standard from Mars SRO and install LTTng, LTTng
Kernel, LTTng UST, GDBTrace and PCAP Network Analysis from the
Trace Compass release Update site.
http://download.eclipse.org/tracecompass/releases/1.0.0/repository

Try to update the installation using the Trace Compass update site
http://download.eclipse.org/tracecompass/mars/milestones

Download Eclipse previous C/C++ EPP package. Try to upgrade using both
update sites:

(TODO find correct job: https://hudson.eclipse.org/packaging/job/luna.epp-
tycho-build/128/artifact/org.eclipse.epp.packages/archive/repository/)
"Mars - http://download.eclipse.org/releases/maintenance”

Verify that installation was successful

Verify that installation was successful

The information about the update sites to use is usually posted on epp-dev Verify that installation was successful

Release outside release train

Download Eclipse standard and install LTTng Kernel, LTTng Control, LTTn
UST, GDBTrace and PCAP Network Analysis from main
Update site: http://download.eclipse.org/tracecompass/stable/repository/ Verify that installation was successful

Download Eclipse standard from Luna SRO and install LTTng, LTTng
Kernel, LTTng UST, GDBTrace and PCAP Network Analysis from the Luna
SRO Linux Tools Update site.
http://download.eclipse.org/linuxtools/update-3.1

Try to update the installation using the Trace Compass update site.

http://download.eclipse.org/tracecompass/stable/repository/ Verify that installation was successful

N/A

N/A



Section Pass

Junit Tests

Ubuntu 12.04 64 bit and on

Target Hudson

Step Test Case Action
1 Junit Test Cases
1.1 CTF Core Tests Plug-in Run manually or with Jenkins
1.2 CTF Parser Tests Plug-in Run manually or with Jenkins
1.3 State System Core Tests Plug-in  Run manually or with Jenkins
1.4 TMF Core Tests Plug-in Run manually or with Jenkins
1.5 TMF Ul Tests Plug-in Run manually or with Jenkins
1.6 TMF Ul SWTBot Tests Plug-in Run manually or with Jenkins
CTF Support for TMF SWTBot
1.7 Tests Plug-in Run manually or with Jenkins
TMF Xml Analysis Core Tests
1.8 Plug-in Run manually or with Jenkins
TMF Xml Analysis Ul Tests Plug-
1.9 in Run manually or with Jenkins
1.10 LTTng Control Core Tests Plug-in Run manually or with Jenkins
1.11 LTTng Control Ul Tests Plug-in  Run manually or with Jenkins
LTTng Kernel Analysis Core Tests
1.12 Plug-in Run manually or with Jenkins
LTTng Kernel Analysis Ul Tests
1.13 Plug-in Run manually or with Jenkins
LTTng Kernel Ul SWTBot Tests
1.14 Plug-in Run manually or with Jenkins
LTTng Userspace Tracer Analysis
1.15 Core Test Plug-in Run manually or with Jenkins
LTTng Userspace Tracer Analysis
1.16 Ul Test Plug-in Run manually or with Jenkins
GDB Tracepoint Analysis Core
1.17 Tests Plug-in Run manually or with Jenkins
GDB Tracepoint Analysis Ul Tests
1.18 Plug-in Run manually or with Jenkins

JUnits

Verification

All test cases passed
All test cases passed
All test cases passed
All test cases passed
All test cases passed
All test cases passed

All test cases passed
All test cases passed
All test cases passed

All test cases passed
All test cases passed

All test cases passed
All test cases passed
All test cases passed
All test cases passed
All test cases passed
All test cases passed

All test cases passed

Fail

To Do

Comment

[ 0 o

Pass
Pass
Pass
Pass
Pass
Pass

Pass

Pass

Pass

Pass
Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Comment



Target:

Step

ey

N

44

4.4

4.5
4.6
4.7

wv

Section
TMF - EventsEditor

Test Case

Preparation
Preparation step 1

Trace bookmarks

Pass

Action

Open and reset LTTng Kernel perspective

Moved to sheet "BookmarksView"

Experiment bookmarks Moved to sheet "BookmarksView"

Filter

Filter

Cancel filter

Un-filter
Filter & Search
Search &Filter

Time Synchronization
Mouse synchronization
Key synchronization

Search synchronization

In the filter bar, enter some regex

In the filter bar, enter some regex, then quickly press ESC
before filtering is done

In the filter bar, clear the regex, or press DEL while table has

focus

In the filter bar, enter some regex; likewise in the search bar
In the search bar, enter some regex; likewise in the filter bar

Select any event in the table with the mouse button

Select any event in the table using Up, Down, PageUp,
PageDown, Home, End

In the search bar, enter some regex, then search again with

Enter/Shift-Enter

In any other view that supports time synchronization, select a

External synchronization time.

Range selection

Event Synchronization

Open trace

Mouse synchronization

Key synchronization

Select an event with left button, press shift key and click select

another event

Open an LTTng CTF Kernel trace

Select any event in the table with the mouse button

Select any event in the table using Up, Down, PageUp,
PageDown, Home, End

EventsEditor

Fail

Verification

LTTng Kernel perspective opens with correct views.

Only events matching regex are displayed. Top and
bottom filter status rows update while filtering is
ongoing. When filtering is done, status rows show
number of matching events.

Only some events matching regex are displayed. Status
rows show partial number of matching events, with
different 'stop' icon.

All events are displayed. Selected event remains
selected and visible. Status rows are removed.

Events are filtered and highlighted accordingly
Events are filtered and highlighted accordingly

Other views are synchronized to the selected event's
time

Other views are synchronized to the selected event's
time

Other views are synchronized to the selected event's
time

The Ffirst event at or following the selected time is
selected and visible.

Range of events are highlighted. Selection range is
updated in other views that support range selection

Verify that an editor is opened showing LTTng Kernel
specific columns. Views are updated with the new
trace.

The Properties view is updated with the selected
event's Property and Value. Timestamp and Content
are expandable.

The Properties view is updated with the selected
event's Property and Value. Timestamp and Content
are expandable.

Type

To Do

Comment

7 [ o |

SWTBot

Manual

Manual

Manual
SWTBot
SWTBot

Manual

Manual

Manual

Manual

Manual

SWTBot

Manual

Manual

Pass

Pass

Pass

Pass
Pass
Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Comment



6.4

6.5

71

7.2

7.3

7.4

8.1

8.2

9.1

Search synchronization

External synchronization

Source Code / Model
Lookup

Preparation

Open call site

Open call site (no source
code)

Open model URI

Export to text

Export CTF trace

Export Other Trace

Swap Columns and
Change Fonts

Swap columns in events
table

EventsEditor

The Properties view is updated with the selected
In the search bar, enter some regex, then search again with  event's Property and Value. Timestamp and Content
Enter/Shift-Enter are expandable.

In any other view that supports time synchronization, select a The Properties view is updated with the selected
time. The selected event in the editor is updated. Then give  event's Property and Value. Timestamp and Content
focus back to the editor. are expandable.

1) Download traces.zip (if necessary) and unzip into a local
directory ${local}

2) Unzip traces/c_project_callsite.zip and
traces/callsite.zip to your local disk.

3) Import demo C project to the Eclipse workspace of zip
file c_project_callsite.zip

4) Import the test trace of zip file callsite.zip to a tracing
project.

Select trace type "Generic CTF Trace" and open the trace

1) select event in table

2) click right mouse button Verify that correct source code file and line number is
3) select "Open Source Code" menu item opened

1) Close source code project

2) select event in table Since the source code is not available the no source
3) click right mouse button code file is opened. Instead a error dialog is opened
4) select "Open Source Code" menu item (with title "FileNotFoundException")

1) select event in table (e.g. 1st event) Since the model is not available the model element is
2) click right mouse button not shown. Instead a error dialog is opened (with title
3) select "Open Model Element" menu item "FileNotFoundException")

Make sure that a progress monitor dialog is opened

1) Open a CTF trace (e.g. LTTng Kernel) during the export. After finishing make sure that the
2) Click right mouse button text file exists and it contains the events stored in the
3) Select "Export To Text" menu item file. Verify that the columns are printed as shown in the
4) Enter a file name and location events table and that they are separated by tab
5) Press OK character.

Make sure that a progress monitor dialog is opened
1) Open a trace other than CTF trace during the export. After finishing make sure that the
2) Click right mouse button text file exists and it contains the events stored in the
3) Select "Export To Text" menu item file. Verify that the columns are printed as shown in the
4) Enter a file name and location events table and that they are separated by tab
5) Press OK character.

1) Open a trace
2) Drag a column
Covered by SWTBot tests

Manual

Manual

Manual

Manual

Manual

Manual

Manual

SWTBot



EventsEditor

1) Open the preferences
2) select new font for trace types
3) press aﬁply
8.2  Change fonts 4) verify that the font changed Covered by SWTBot tests SWTBot

1) Open the preferences
2) Reset the font settings
3) Press apply
8.3 Reset fonts 4) verify that the font changed Covered by SWTBot tests SWTBot




Section
TMF - Project View

Target: Ubuntu 14.10 64 bit

Step

1.1
1.2

2.1
22
2.3

31
3.2

3.10

3.1

Test Case

Preparation
Step 1
Step 2

Project Creation
New Project Wizard
Create project
Project structure

Traces Folder

Preparation
Traces Folder menu
Trace Import Wizard

Import single custom text trace
(link to workspace)

Import Single custom XML trace
(link to workspace)

Import LTTng Kernel CTF trace
(link to workspace)

Rename + copy import

Overwrite + copy import

Skip

Default overwrite

Import unrecognized

Import unrecognized (ignore)

Pass
160

Action

Open LTTng Kernel perspective
Open Navigator View (used for independent verification)

Open New Tracing Project Wizard
Specify a project name and finish
Open the new Tracing project

1) Download traces.zip (if necessary) and unzip into a local

directory ${local}

2) Import Custom Text and XML parsers
(ExampleCustomXmlParser.xml,
ExampleCustomTxtParser.xml) from directory
traces/customParsers into your workspace from the
Manage Custom Parsers dialog.

Select the Traces folder and open its context menu
Select Import
1) Browse to directory ${local}/traces/import/

2) Select trace ExampleCustomTxt.log
3) Keep <Auto Detection>, Select "Import unrecognized

traces”, unselect "Overwrite existing without warning" and

select "Create Links to workspace" and
4) press Finish

redo 3.1-3.3 but this time select ExampleCustomXml.xml

redo 3.1-3.3 but this time select directory kernel-overlap-
testing/

redo 3.3, 3.4, 3.5. However, Unselect "Create Links to
workspace"

When dialog box appear select Rename

redo 3.3, 3.4, 3.5. However, Unselect "Create Links to
workspace"

When dialog box appear select Overwrite

redo 3.3, 3.4, 3.5. However, Unselect "Create Links to
workspace"

When dialog box appear select Skip

redo 3.3, 3.4, 3.5. However, Unselect "Create Links to

workspace" and select "Overwrite existing without warning”

1) Open Import wizard (see 3.1-3.2)

2) Browse to directory ${local}/traces/import

3) Select trace unrecognized.log

4) Keep <Auto Detection>, Select "Import unrecognized

traces", unselect "Overwrite existing without warning" and

select "Create Links to workspace" and
5) press Finish

redo 3.10, however unselect "Import unrecognized traces"

ProjectView

Fail

Verification

LTTng perspective opens with correct views
Navigator View opens

Tracing Project Wizard opens
Tracing project appears in Project Explorer/Navigator
Project contains Experiments and Traces folders

Correct menu opens (Import, Refresh)
Trace Import Wizard appears

Imported trace appear in Traces Folder and the Trace
Type Tmf Generic is set. Make sure trace can be opened

Imported trace appear in Traces Folder and the Trace
Type "Custom XML log" is set. Make sure that trace can
be opened

Imported trace appear in Traces Folder and the Trace
Type "LTTng Kernel" is set. Make sure that trace can be
opened

Traces are imported with new name that has a suffix (2)
at the end. Make sure that imported traces are copied
to the project.

Existing traces are deleted and new traces are
imported. Make sure that imported traces are copied to
the project and can be opened

Make sure that no new trace is imported

Make sure that no dialog box appears (for renaming,
overwriting, skipping) and existing traces are
overwritten). Make sure trace can be opened

unrecognized.log is imported with trace type unknown.
The default text file icon is displayed. The trace, when
opened, is displayed in the text editor.

unrecognized.log is not imported

Type

SWTBot
SWTBot

SWTBot
SWTBot
SWTBot

SWTBot
SWTBot

SWTBot

Manual

SWTBot

Manual

Manual

Manual

SWTBot

Manual

Manual

To Do

Pass
Pass

Pass
Pass
Pass

Pass
Pass
Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Comment
9

Comment

Either the text editor will open or the system editor, depending on the file associations in your installation



3.12

3.13

3.14

3.15

3.16

3.17

3.18

Preparation

Import CTF trace by selection
metadata file only

Preparation

Recursive import with auto-
detection (Rename All)

Preparation

Recursive import with auto-
detection (Overwrite All)

Preparation

Recursive import with auto-
detection (Skip All)

Preparation

Recursive import with auto-

detection (test rename, overwrite

and skip)
Preparation

Recursive import with specific
trace type 1 (Skip All)

Preparation

Recursive import with specific
trace type 2 (Skip All)

Preparation

Delete all traces in project - Right mouse click on Traces
folder and select "Clear"

Redo 3.5, However only select metadata file instead of
directory trace

Delete all traces in project

1) Open Import wizard (see 3.1-3.2)

2) Browse to directory ${local}/traces/import

3) select directory import

4) Keep <Auto Detection>, Select "Import unrecognized
traces”, unselect "Overwrite existing without warning",
select "Create Links to workspace" and unselect "Preserve
Folder Structure”

Sg press Finish

6) When dialog appears select "Rename All"

Delete all traces in project

1) Open Import wizard (see 3.1-3.2)

2) Browse to directory ${local}/traces/import/

3) select directory import

4) Keep <Auto Detection>, Select "Import unrecognized
traces”, unselect "Overwrite existing without warning",
select "Create Links to workspace" and unselect "Preserve
Folder Structure”

5) press Finish

6) When dialog appears select Overwrite All"

Delete all traces in project

1) Open Import wizard (see 3.1-3

2) Browse to directory ${local}/traces/|mport/

3) select directory import

4) Keep <Auto Detection>, Select "Import unrecognized
traces”, unselect "Overwrite existing without warning" and
select "Create Links to workspace" and

5) press Finish

6) When dialog appears select Skip All"

Delete all traces in project

1) Open Import wizard (see 3.1-3.2)

2) Browse to directory ${local}/traces/import/

3) select directory import

4) Keep <Auto Detection>, Select "Import unrecognized
traces”, unselect "Overwrite existing without warning",
select "Create Links to workspace" and unselect "Preserve
Folder Structure"

5) press Finish

6) When dialog appears select "Rename"

7) When dialog appears select "Overwrite"

8) When dialog appears select "Skip"

Delete all traces in project

1) Open Import wizard

2) Browse to directory ${local}/traces/import/

3) select directory import

4) Select trace type "Generic CTF Trace", Select "Import
unrecognized traces", unselect "Overwrite existing without
warning", select "Create Links to workspace" and unselect
"Preserve Folder Structure"and

5) press Finish

6) When dialog appears select Skip All"

Delete all traces in project

1) Open Import wizard gsee 3.1-3.2)

2) Browse to directory ${local}/traces/import/

3) select directory import

4) Select trace type "LTTng Kernel Trace", Select "Import

unrecognlzed traces", unselect "Overwrite e)ﬂstmg without

warnlng select "Create Links to workspace" and unselect
"Preserve Folder Structure”

5) press Finish

6) When dialog appears select Skip All"

Delete all traces in project

ProjectView

Imported trace appear in Traces Folder and the Trace
Type "LTTng Kernel" is set. Make sure that trace can be
opened

All Traces are imported with respective trace type set.
Traces with name clashes are imported with suffix (2).
1 trace (unrecognized.log) is imported with trace type
unknown. Make sure that traces can be opened which
have a trace type set. The unknown trace type should

open with the text editor.

All Traces are imported with respective trace type set.
Traces with name clashes are overwritten . 1 trace
(unrecognized.log) is imported with trace type
unknown. Make sure that traces can be opened which
have a trace type set. The unknown trace type should
open with the text editor.

All Traces are imported with respective trace type set.
Traces with name clashes are not imported. 1 trace
(unrecognized.log) is imported with trace type
unknown. The unknown trace type should open with
the text editor.

All Traces are imported with respective trace type set.
Traces with name clashes are either renamed,
overwritten or skipped as per dialog action. Make sure
that traces can be opened which have trace type set.
Tge unknown trace type should open with the text
editor.

After selecting trace type, verify that button "Import
unrecognized traces" is disabled.

4 CTF traces are imported with trace type "Generic CTF
Trace" . Make sure that these traces can be opened

After selecting trace type, verify that button "Import
unrecognized traces" is disabled.

One LTTng Kernel trace is imported with trace type

"LTTng Kernel Trace". Make sure that this trace can be
opened.

10

Manual

Manual

Manual

Manual

Manual

Manual

Manual



3.19

3.20

3.21

3.22

3.23

3.24

3.25

3.26

3.27

3.28
3.29

3.30

3.31

Recursive import with specific
trace type 3 (Skip All)

Preparation

Recursive import with specific
trace type 4 (Skip All)

Preparation

Import CTF trace by selection
metadata file only

Import to default project

Import wizard with no project
selected

Preparation

1) Open Import wizard

2) Browse to directory ${local}/traces/import/

3) select directory import

4) Select trace type "LTTng UST Trace", Select "Import
unrecognized traces", unselect "Overwrite existing without
warning", select "Create Links to workspace" and unselect
"Preserve Folder Structure"

5) press Finish

6) When dialog appears select Skip All"

Delete all traces in project

1) Open Import wizard (see 3.1-3.2)

2) Browse to directory ${local}/traces/import/

3) select directory import

4) Select trace type "Tmf Generic", Select "Import
unrecognized traces", unselect "Overwrite existing without
warning", select "Create Links to workspace" and unselect
"Preserve Folder Structure"

5) press Finish

6) When dialog appears select Skip All"

Delete all traces in project

Redo 3.5, However only select metadata file instead of
directory trace

1) Delete project "Tracing"
2) Import a trace using import wizard (File > Import... >
Tracing > Trace Import)

Open import wizard while not having a project seleted
Delete all traces in project
D&D a few LTTng traces from another Tracing project's

Drag and Drop from other Tracing Traces folder

Drag and Drop from non-Tracing

Drag and Drop from external

Drag and Drop of trace with
existing name

Drag and Drop of trace with
existing name (2nd time)

Import destination
Preparation

Recursive import with preserved
folder structure

Recursive import with preserved
folder structure (Skip All)

D&D a few files from a non-Tracing project

D&D a few files from an external file manager

2)[3&D a trace with name of an existing trace into traces
older
2) Confirm the renaming of traces

Redo test 7.8 with the same trace and same destination
folder

Open Import wizard
Delete all traces in project

1) Open Import wizard gsee 3.1-3.2)

2) Browse to directory ${local}/traces/import/

3) select directory import

4) Select trace type "TmF Generic", unselect "Overwrite
existinf; without warning", select "Create Links to workspace"
and select "Preserve Folder Structure"

5) press Finish

1) Open Import wizard gsee 3.1-3.2)

2) Browse to directory ${local}/traces/import/

3) select directory import

4) Select trace type "Tmf Generic", unselect "Overwrite
existing without warning", select "Create Links to workspace"
and select "Preserve Folder Structure"

5) press Finish

6) When dialog appears select "Skip All"

ProjectView

After selecting trace type, verify that button "Import
unrecognized traces" is disabled.

3 LTTng UST traces are imported with trace type
"LTTng UST Trace". Make sure that these traces can be

opened. Manual

All text files in directories are imported as trace and
trace type "Tmf Generic" is set. Note that trace type
validation only checks for file exists and that file is not
a directory. Make sure that these traces can be opened.
However traces with wrong trace type won't show any

events in the table. Manual

CTF trace is imported with correct trace type set. Trace

can be opened. Manual

Make sure the project with name Tracing is created and
trace is imported to that project.
Verify that "Into Folder" points to project

Tracing/Traces. Also make sure that project Tracing was
create:

Manual

Manual
Manual
Selected traces are added to the Traces folder with
proper icon. Trace can be opened.

Selected traces are added to the Traces folder with

default icon. Files can be opened wit the default
editor.

Manual

Manual

Selected traces are added to the Traces folder with
default icon. For actual traces Trace type is detected
automatically. Trace can be opened, For non traces the
files are added with default icon and they can be

opened with the default editor. Manual

Verify that trace is added into the traces folder with
the trace name of the orignal trace plus a suffix 2

Verify that trace is added into the traces folder with
the trace name of the orignal trace plus a suffix 3

Verify that "Into Folder" text box cannot be updated

Manual

Manual
Manual

All Traces are imported with respective trace type set.
The folder "clashes" is imported with its traces inside.
Make sure that traces can be opened which have a

trace type set. Manual

The wizard should finish quickly as no trace will be
imported. Make sure that traces can be opened which
have a trace type set.

Manual

11



3.32

3.33

3.34

3.35

3.36

3.37

3.38

3.39

4.1
4.2
4.3
4.4
4.5
4.6
4.7

4.8

4.9

51
52

Recursive import with preserved
folder structure (Rename All)

Preparation

Delete with mixed selection of

traces and folders

Delete multiple folders

Clear single Traces folder

Clear multiple Traces folder
Preparation

Import from archive, preserve

folder structure
Preparation

Import from archive, no preserve

folder structure
Preparation

Import from archive, rename all

Trace

Trace menu

Open trace

Copy trace

Rename trace

Delete trace

Open Trace (Accelerator)
Delete Trace (Accelerator)

Open Trace (double click)
Open Trace (already open)

Experiments Folder

Experiments menu
Create experiment

1) Open Import wizard (see 3.1-3.2)

2) Browse to directory S(local)/traces/lmport/

3) select directory i import

4) Select trace type "Tmf Generlc unselect "Overwrite

ProjectView

existing without warning", select " ‘Create Links to workspace" All Traces are imported with respective trace type set

and select "Preserve Folder Structure"
5) press Finish
6) When dialog appears select "Rename All"

Delete all traces in project

1) Create a trace folder under the "Traces" folder

2) Import 2 traces under the folder

3) Open one of the traces.

4) Select the trace folder and both traces in the Project
Explorer view

5) Right-click, Delete. Click OK.

1) Create 2 trace folders under the "Traces" folder
2) Import a trace in each folder

3) Select both trace folders

4) Right-click delete

1) Add a few folders and traces under the Traces folder
2) Right-click on the Traces folder, Clear. Click OK.

1) Create 2 trace projects, both containing a few traces.
2) Select both Traces folder
3) Right-click on one of the trace folders, Clear. Click OK.

Delete all traces in project

1) Open Import wizard (see 3.1-3.2)
2) Select archive file: traces.zip
3) select directory the root directory

with suffix (2). The folder "clashes" is imported with its
traces inside. Make sure that traces can be opened
which have a trace type set.

A dialog should ask the user to confirm deletion of the
selected elements. Clicking OK should remove all that
was selected. The editor should be closed
automatically.

A dialog should ask the user to confirm deletion of the
folders. Clicking OK should remove all that was
selected.

A dialog should ask the user to confirm the clear of the
fo{der. glicking OK should everything under all that was
selected.

A dialog should ask the user to confirm the clear of the
folders. Clicking OK should everything under all that
was selected.

4) Select trace type "Automatic”, unselect "Overwrite existing All the files get imported under their respective

without warning" and select "Preserve Folder Structure"
5) press Finish

Delete all traces in project

1) Open Import wizard (see 3.1-3.2)
2) Select archive file: traces.zip
3) select directory the root directory

folders. The CTF traces can be opened (kernel-overlap-
testing, simple_server...)

All the files get imported. The CTF traces can be
opened (kernel-overlap-testing, simple_server...). The

4) Select trace type "Automatic”, unselect "Overwrite ex1st|ng traces with name clashes are added with the trace

without warning” and unselect " "Preserve Folder Structure”
5) press Finish
6) Select Rename All when dialog comes up.

DO NOT delete all traces in project

1) Open Import wizard (see 3.1-3.2)
2) Select archive file: traces.zip
3) select directory the root directory

name of the orignal trace plus a suffix 2
(ExampleCustom*, kernel-overlap-testing,
simple_server...).

4) Select trace type "Automatic”, unselect "Overwrite existing All the files get imported. The CTF traces can be

without warning" and unselect "Preserve Folder Structure"

5) press Finish
6) Select Rename All when dialog comes up.

Select an LTTng trace and open its context menu
Select the Open menu
Select the Copy menu and provide a new name. Open.

Select the Rename menu and provide a new name. Reopen.

Select the Delete menu and confirm deletion
Select trace and press Enter
Select trace and press Delete and confirm deletion

Double-click a trace

Open two traces. Open the first trace again.

Select the Experiments folder and open it context menu
Select the New menu and provide experiment name

opened (kernel-overlap-testing, simple_server...). The
traces with name clashed are added with the trace
name of the orignal trace plus a suffix 2 or 3 or 4.

Correct menu opens (Open, Copy, Rename, ...)
Trace is opened and views are populated
Trace is replicated under the new name

Trace is renamed. The trace editor is closed.
Trace is deleted. The trace editor is closed.
Trace is opened

Trace is deleted. The trace editor is closed.

Trace is opened
The first trace editor is simply brought to front.

Correct menu opens (New, Import XML Analysis,
Refres|

Experiment appears under folder, no traces yet
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6.1
6.2
6.3
6.4

6.5
6.6
6.7
6.8
6.9

6.10

6.11

71
7.2

73

7.4

7.5

7.6

7.7

7.8

7.9

7.10

711

8.1
8.2
83
8.4

85

9.1

9.2

9.3

9.4

Experiment
Experiment menu
Select Traces dialog
Select traces

Open experiment
Copy experiment

Rename experiment
Delete experiment

Open Experiment (Accelerator)
Delete Experiment (Accelerator)

Delete Experiment (open
experiment)

Select Traces while Experiment is

open

Experiment Traces
Trace menu
Open trace

Remove trace

Drag and Drop from Traces

Select an experiment and open its context menu
Select the Select Traces menu

Select a few LTTng traces and finish

Select the Open menu

Select the Copy menu and provide a new name. Open.
Select the Rename menu and provide a new name. Open.
Select the Delete menu and confirm deletion

Select an Experiment and press Enter

Select an Experiment and press Delete and confirm deletion

Open an experiment, select expereiment and press Delete
and confirm deletion

Open an experiment and select an additional trace (see 6.3)

Select an LTTng trace and open its context menu
Select the Open menu

Open Experiment, select the Remove menu and confirm
remova

D&D a few LTTng traces from the Traces directory
D&D a few LTTng traces from another Tracing project's

Drag and Drop from other Tracing Traces folder

Drag and Drop from non-Tracing D&D a few traces from a non-Tracing project

Drag and Drop from external

Drag and Drop from external

(non-traces)

Drag and Drop of trace with

existing name

Drag and Drop of trace with

existing name (2nd time)

Drag and Drop of trace while

Experiment is open

Propagation
Preparation

Rename propagation
Delete propagation
Propagate trace type 1

Propagate trace type 2

Properties View
Synchronization

Trace synchronization

Other trace nodes
synchronization

Check trace properties

Check trace properties -
experiment

D&D a few traces from an external file manager

D&D a few files (non-traces) from an external file manager

ProjectView

Correct menu opens (Select, Open, Copy, Rename, ...)
Select Traces dialog is open and populated w/ traces
Selected traces are imported in the experiment
Experiment is opened and views are populated

Experiment is replicated under the new name
Experiment is renamed

Experiment is deleted

Experiment is opened

Experiment is deleted

Experiment is closed and deleted

Experiment is closed and selected traces is imported to
the experiment

Correct menu opens w/ Copy disabled + Remove
Trace is opened and views are populated

Experiment is closed, trace is removed from
experiment

Selected traces are added to the experiment with
proper icon. Experiment can be opened.

Selected traces are added to the experiment + Traces
with proper icon. Experiment can be opened.
Selected traces are added to the experiment + Traces
with proper icon. Experiment can be opened.

Selected traces are added to the experiment + Traces
with proper icon. Experiment cannot be opened.

Selected traces are added to the experiment + Traces
with proper icon. Experiment can be opened.

1) D&D a trace with name of an existing trace into experiment Verify that trace is added into the traces folder and

folder
2) Confirm the renaming of traces

Redo test 7.8 with the same trace and same destination
older

Open an experiment and D&D a trace from the Traces
directory (see 7.4)

Copy experiment

In Traces folder, rename a trace showing in both experiments
In Traces folder, delete a trace showing in both experiments
Add a trace to 2 experiments. Change its type from Traces

Add a trace to 2 experiments. Change its type from one of
the experiments

Select a trace under a Traces folder in Project Explorer view.
Repeat with trace under an Experiment.

Select a Traces folder, Experiments Folder, or an experiment
in Project Explorer view.

Open an LTTng kernel trace, click on the trace, check the new
properties view.

Open an experiment which containes LTTng kernel traces,
click on the experiment, check the new properties view.

experiment folder with the trace name of the orignal
trace plus a suffix 2

Verify that trace is added into the traces folder and
experiemnt folder with the trace name of the orignal
trace plus a suffix 3

Experiment is closed and selected traces is imported to
the experiment

Selected experiment is replicated

New name is propagated to both experiments
Selected trace is removed from both experiments
All occurences of that trace are updated

All occurences of that trace are updated

The Properties view is updated with the selected
trace's "Resource properties" Property and Value. The
"Info > type" property shows the selected trace
category and trace type name.

The Properties view is updated with the selected item's
Property and Value. For Experiment verify the "type"
property is set.

The "Trace properties” should be populated

The "Trace properties” should be populated for every
subtrace
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Failed in 3.0, 3.1, 3.2, TC 0.1 When copying a renamed experiment the orignal named experiment is

ps://bugs.eclipse.c

w_bug.cgi?id=436888

New feature ... not implemented yet



10

10.1

10.2
10.3

1

1.1

1.2

113

11.4

11.5

11.6

11.7

11.8

11.9

11.10

11.11

11.12

11.13

12

121

12.2

123

12.4

12.5

12.6

Trace Type Selection

Preparation
Trace properties
Trace filtering

Supplementary Files

Preparation

Create Supplementary File (State
History File) from trace

Trace Context sensitive menu

Delete Supplementary Files
Action

Sellect and delete State History
File

Create Supplementary File (State
History File) from experiment

Delete Supplementary Files
Action

Sellect and delete State History
File

Select and delete multiple State
History files

Delete Trace

Delete Experiment

Delete Experiment Trace

Delete Supplementary Files
Action while trace is open

Link With Editor

Preparation

Select trace/experiment in Editors Select several traces and experiments one after each other in

area

Select opened
traces/experiments in Project
Explorer

Preparation

Select trace/experiment in Editors Select several traces and experiments one after each other in

area
Select opened
traces/experiments in Project
Explorer

Import an file with unrecognized trace type
(${local}/traces/import/unrecognized.log)

Select the trace and open the Properties View
Select an experiment and open Select Traces dialog

1) In Project Explorer remove filter for hidden resources
(Coolbar menu > Customize View... > unselect '.* resources)
2) Create Experiment with 2 LTTng CTF traces in it

Open a LTTng CTF trace and wait for indexing to finish

a) Select trace under Folder Traces and click right mouse
button

b) Redo test: Select trace under Experiment Folder
) Redo test: Select Experiment

1) Select trace and click right mouse button
2) Select 'Delete Supplementary Files..."

Select <trace name>/StateHistory.ht file and click on 'Ok’

Open Experiment with 2 LTTng CTF traces

1) Select Experiment and click right mouse button
2) Select 'Delete Supplementary Files...'

Select one history file (<trace name>/StateHistory.ht) and
click on 'Ok’

1) Redo 11.2 and 11.6
2) Select both history files and click on 'Ok’

a) Redo 11.2 to create Supplementary File
b) Delete trace

a) redo 11.6 to create experiment and Supplementary File
b) delete Experiment

a) redo 11.6 to create experiment and Supplementary File
b) remove traces under Experiment

Open trace and then redo 11.4

1) In Project Explorer make sure that "Link with Editor"
button is selected
2) Open multiple traces and experiments

Editors area

Select several open traces and experiments one after each
other in Project Explorer

1) In Project Explorer make sure that "Link with Editor"

button is not selected
2) Open multiple traces and experiments (if not open)

Editors area

Select several open traces and experiments one after each
other in Project Explorer

ProjectView

Imported trace appear in Traces with default icon. File
is can be opened by default Editor (either Eclipse text
or system editor depending on plug-ins installed)

Selected trace type is blank

Untyped trace does not appear in list

Verify that .tracing directory is shown under the project
Verify that StateHistory.ht is created under

.tracing/<trace name>/.

Verify that menu item 'Delete Supplementary Files..."is
shown in the context-sensitve menu

Verify that confirmation dialog box is opend and <trace

name>/StateHistory.ht is listed
Make sure that file .tracing/<trace

name>/StateHistory.ht is deleted from the project

explorer view

Verify that two StateHistory.ht files are created under
.tracing/<trace1 name>/ and ./tracing/<trace2 name>/
respectively. Also verify, that supplementatry folder for
the experiment ./tracing/<exp name>_exp is created.

Verify that confirmation dialog box is opend and shows

3 root entries:

<exp name>, <trace1 name> and <trace2 name>, with
their respective supplementary files below

Make sure that the selected file .tracing/<trace
name>/StateHistory.ht is deleted from the project

explorer view

Make sure that both history files are deleted under
.tracing/<trace1 name>/ and .tracing/<trace2 name>/

respectively

Verify that supplementary directory .tracing/<trace

name>/ is deleted.

Verify that supplementary File StateHistory.ht
.tracing/<trace1 name>/ and ./tracing/<trace2 name>/
are NOT deleted. Also verify that the supplementary
folder for the experiment ./tracing/exp_name_exp is

deleted.

Verify that supplementary File StateHistory.ht
.tracing/<trace1 name>/ and ./tracing/<trace2 name>/

are NOT deleted

Verify that trace is closed and supplementary files are

deleted

Verify that after each selection the corresponding trace
or experiment element is selected in the Project

Explorer

Verify that after each selection the corresponding trace
or experiment is brought to the top in the Editors area

Verify that selection in Project Explorer doesn't change

Verify that Editor in focus is not changed
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ProjectView

13 Trace Package Export Wizard
1) Import 2 traces that generate supplementay files (trace2,
kernel_vm
Zg Open both traces, wait for the indexing to finish
13.1 Preparation 2) Add bookmarks in the two traces
Open the trace package export  Click on “File”, “Export...", “Tracing”, “Trace Package Export” A wizard should appear with a list of projects and
13.2 wizard and click Next traces to select. Next button should be disabled. Manual

Next should be become enabled when the first trace is
On the left side, select the project in which the traces were  selected. If all traces are unselected, the Next button is

13.3 Select Traces imported. Then on the right side, selected both traces. disabled. Manual
With traces selected, press the Deselect All button. Then Next should become disabled after Deselect All,
13.4 Deselect/Select All press on the Select All button. Click Next. enabled after Select All. Manual

All elements in the trace tree are unselected, the
Approximate uncompressed size field changes to a
135 Trace element selection Unselect the trace2 element lower number. Manual

All elements in the trace tree are unselected, the
Approximate uncompressed size field changes to 0. The
13.6 Trace sub-element selection Unselect the kernel_vm > Trace element Next button is disabled. Manual

When Select Allis clicked, all the tree elements are
selected, the approximate size increases. When
With nothing selected, click Select All. Then click Deselect All. Deselect Allis clicked, all the tree elements are

13.7 Select/Deselect All Then click Select All again. deselected and the approximate size decreases. Manual
1) Click on the Browse button. A file chooser dialog comes up. Whe the destination file
2) Select a location on the filesystem is entered, the “To archive file” is filed with
13.8 Archive file selection 3) Enter the file name export.tar export.tar.gz. The Finish button should be enabled. Manual
Change export options, change
13.9 compression Unselect the “Compress” checkbox. The name of the archive file changes to export.tar Manual
Change export options, change
13.10 format Change to Zip format The name of the archive file changes to export.zip Manual
Change export options, change
13.11 format and compression Change to Tar format then select the Compress checkbox.  The name of the archive file changes to export.tar.gz Manual
A progress bar should appear at the bottom the the
dialog and it should disappear upon completion. The
13.12 Finish the wizard Click Finish export.tar.gz file should be created on the file system.  Manual
The Archive file name should be remembered and
already filled. A dialog should prompt the user to
overwrite. Answering No should keep the wizard
Open the wizard again and select the traces (step 13.2, 13.3). opened. Answering Yes should re-export the archive
13.13 Overwrite Click Finish. and close the wizard. Manual
Open the wizard again and select the traces (step 13.2, 13.3).
13.14 Verify formats This time, choose Zip format. Click Finish. The export.zip file should be created on the file system Manual
In both archives, verify that it contains:
1) A trace folder for each trace containing all the trace
files (excluding supplementary files)
I%)l A .tracing folder containing all the supplementary
iles
3) An export-manifest.xml file listing the trace files,
13.15 Verify content Open the tar.gz and the zip files in an archive manager. supplementary files and bookmarks Manual
Verify that the exported archive contains:
In both archives, verify that it contains:
1) A Traces folder containing all the trace files
(excluding supplementary files)
Open the wizard again and select the traces (step 13.2, 13.3). 2) No .tracing folder
This time, unselect both Supplementary files subtrees. Click  3) An export-manifest.xml file listing the trace files and
13.16 Partial selection Finish. bookmarks Manual
14 Trace Package Import Wizard
Create an empty tracing project. Make sure you have
export.tar.gz available from the Trace Package Export Wizard
(13) test case, which should include everything including
14.1 Preparation trace files, supplementary files and export-manifest.xml.
Open the trace package import  Click on “File”, “Import...", “Tracing”, “Trace Package Import” The First page of the wizard should appear (Choose
14.2 wizar and click Next content to import) Manual
Click the Select button. Choose the previously created The Into project field gets filled with the selected
14.3 Project Selection project. project name. Manual
Finish should be become enabled when the first trace is
13 Click on the Browse button. selected. If all traces are unselected, the Next button is
14.4 Archive file selection 2) Browse for export.tar.gz on the file system disabled. Manual
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14.5
14.6
14.7

14.8

14.9

14.10
14.11

14.12

14.13
15

15.1

15.2

15.3

15.4

15.5

15.6

15.7

15.8

15.9

Deselect/Select All
Trace element selection
Trace sub-element selection

Select/Deselect All

Finish the wizard

Supplementary Files
Bookmarks

Open from bookmark

Overwrite
Time Offsetting

Preparation

Apply time offset dialog - trace
selection

Apply time offset dialog - folder
selection

Apply time offset dialog -
experiment selection

Apply time offset dialog - Basic
mode

Apply time offset dialog -
cumulative offset

Clear time offset

Apply time offset dialog -
Advanced mode

Apply time offset dialog -
Advanced mode - compute from
selection

With traces selected, press the Deselect All button. Then
press on the Select All button.

Unselect the trace2 element
Unselect the kernel_vm > Trace element

With nothing selected, click Select All. Then click Deselect All.
Then click Select All again.

Click Finish

Right-click on trace2 in Project Explorer
Open the Bookmarks view

Double click on one of the bookmarks

Open the wizard again (step 13.2) and select the archive file
(step 13.4). Click Finish.

Open Project Explorer view and Properties view. Create an
empty tracing project. Import two different traces to the
project. Open the traces and note their start time. Close the
traces.

Select both trace elements in the Project Explorer view.
Right-click and select Apply Time Offset...

Select the Traces folder element in the Project Explorer view.

Right-click and select Apply Time Offset...

Create an experiment with both traces. Select the
experiment element in the Project Explorer view. Right-click
and select Apply Time Offset...

Select a trace element in the Project Explorer view. Right-
click and select Apply Time Offset... In the Offset in seconds
column, enter a time with seconds and decimals. Click OK.
Open the trace.

Select the same trace element in the Project Explorer view.
Right-click and select Apply Time Offset... In the Offset in
seconds column, enter a time with seconds and decimals.
Click OK. Open the trace.

Select the trace element in the Project Explorer view. Right-
c'l.ick and select Clear time offset. Click OK to confirm. Open
the trace.

Open one trace and close the other trace. Select both trace
elements in the Project Explorer view. Right-click and select
Apply Time Offset... Choose the Advanced radio button.

ProjectView

Finish should become disabled after Deselect All,
enabled after Select All.

All elements in the trace tree are unselected.
All elements in the trace tree are unselected.

When Select Allis clicked, all the tree elements are
selected. When Deselect All is clicked, all the tree
elements are deselected..

A progress bar should appear at the bottom the the
dialog and it should disappear upon completion. The
two traces should appear under the project in Project
Explorer

Delete Supplementary files appears in the content
menu

Bookmarks appear in the list for the imported traces

The corresponding trace opens at the bookmarked
event. Bookmarks are displayed in the event table.

A dialog should prompt the user to overwrite for each
trace. Answering Yes to All should overwrite without
prompting again.

The Apply time offset dialog opens in Basic mode. The
Trglce rl\(ame show both traces and the Offset in seconds
is blank.

The Apply time offset dialog opens in Basic mode. The
Trglce name show both traces and the Offset in seconds
is blank.

The Apply time offset dialog opens in Basic mode. The
Trglce rllame show both traces and the Offset in seconds
is blan

The timestamps in the trace are all offset by the
entered value. The Properties view shows the 'time
offset’ with the entered value.

The timestamps in the trace are all offset by the
cumulative sum of the previous and current entered
value. The Properties view shows the 'time offset' with
the cumulative value.

The timestamps in the trace are back to their original
\é?luis. The Properties view shows the 'time offset' as
ank.

The Apply time offset dialog opens and is switched to
Advanced mode. The Trace name show both traces and
the Offset in seconds is blank. The Reference time for
the opened trace is set to its start time.

Both traces are open. Selecting an event updates the
Reference time for the selected trace, and updates the
Target time for all traces. Pressing the button
computes the Offset in seconds as the difference
between Target time and Reference time for that row.
The trace which has a computed offset is closed when

Double-click the second trace to open it. Select an event in its the OK button is pressed. After reopening, the two
trace editor. Select the first trace editor. Select an event in its previously selected events now have the same

trace editor. Click the button in the dialog row of the second
trace. Click OK. Open both traces.

timestamp. The Properties view shows the 'time offset'
with the computed value.
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15.10

15.11

Apply time offset dialog -
Advanced mode - compute from
entered values

Clear time offset with opened
traces

Select the first trace element in the Project Explorer view.
Ri(?ht-click and select Apply Time Offset... Choose the
Advanced radio button. Double-click the trace name to open
it. Select the Reference time cell and copy the start time.
Select the Target time and paste the value. Edit both values
to different times. Click the button in the trace row. Click OK.
Open the trace.

Open both traces. Select both trace elements in the Project
Explorer view. Right-click and select Clear time offset. Click
OK to confirm. Open the traces.

ProjectView

The trace is opened. The Reference time is set to the
trace start time. The Reference time and Target time
can be copied, pasted, and edited. Pressing the button
computes the Offset based on the current time values.
The trace is closed with the OK button is pressed. After
reopening, the timestamps in the trace are offset
according to the computed value. The Properties view
shows the 'time offset’ with the computed value.

The opened traces are closed when the OK button is
pressed. After reopening, the timestamps in the traces
are back to their original values. The Properties view
shows the 'time offset' as blank.
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BookmarksView

Section Comment
TMF - BookmarksView

Target: Ubuntu 14.10 64 bit

Type To Do

2 [ o |

Test Case Verification Comment

1 Preparation
1.1 Preparation step 1 Open and reset LTTng Kernel perspective LTTng Kernel perspective opens with correct views. SWTBot Pass
2 Trace bookmarks
2.1 Show Bookmarks View Select Bookmarks view (bottom folder) Bookmaks view is shown Manual Pass
Views are populated. Verify that a Kernel events editor is
22 Open trace Open an LTTng CTF Kernel trace opened showing LTTng Kernel specific columns SWTBot Pass
Add a bookmark, by
a) double-clicking on the left margin next to an event Make sure that bookmark icon is shown on left site of the
b) right-clicking the margin and select Add bookmark.... event row and is added to the Bookmarks view with relevant
¢) using the Edit > Add bookmark... menu. information (i.e. Description entered and correct trace
2.3 Add Trace Bookmark Enter the bookmark description in dialog box resource) Manual Pass No Edit menu in Trace Compass RCP
Scroll within event table so that bookmark is not visible anymore and Make sure that event with bookmark is selected and visible in
2.4 Open Trace Bookmark (1)  then double-click on bookmark in Bookmarks View event table Manual Pass
Open another trace #2 and then double-click on bookmark in Make sure that correct trace #1 is brought to top and correct
2.5 Open Trace Bookmark (2)  Bookmarks view event with bookmark is selected in events table Manual Pass
Close the trace #1 and then double-click on bookmark in Bookmarks Make sure that correct trace #1 is opened and correct event
2.6 Open Trace Bookmark (3)  view with bookmark is selected in events table Manual Pass
Make sure that bookmark icon is removed from event table
Delete Bookmark (from Select bookmarks icon in event table right-click on icon and select  and corresponding bookmark is removed from the Bookmarks
2.7 table) "Remove Bookmark" view Manual Pass
Make sure that bookmark icon is removed from event table
Delete Bookmark (from and corresponding bookmark is removed from the Bookmarks
2.8 table) Double-clicking bookmarks icon in event table. view Manual Pass
Make sure that bookmark icon is removed from event table
Delete Bookmark (from Add a bookmark (see 2.4), then select bookmark in Bookmarks view, and corresponding Bookmark is removed from the Bookmarks
29 Bookmarks view) right mouse click and select "Delete". Confirm the deletion. view Manual Pass
3 Experiment bookmarks
Create Experiment with 2 LTTng CTF Kernel traces in it and open  Verify that an Events editor is opened showing LTTng Kernel
3.1 Create and open experiment experiment specific columns Manual Pass
Add a bookmark, by
a) double-clicking on the left margin next to an event Make sure that bookmark icon is shown on left site of the
b) right-clicking the margin and select Add bookmark.... event row and is added to the Bookmarks view with relevant
¢) using the Edit > Add bookmark... menu. information (i.e. Description entered and correct experiment
32 Add Experiment Bookmark ~ Enter the bookmark description in dialog box resource) Manual Pass

Open Experiment Bookmark Scroll within event table so that bookmark is not visible anymore and Make sure that event with bookmark is selected and visible in

33 (1) then double-click on bookmark in Bookmarks View event table Manual Pass
Open Experiment Bookmark Open another trace #2 and then double-click on bookmark in Make sure that correct experiment #1 is brought to top and

34 2) Bookmarks view correct event with bookmark is selected in events table Manual Pass
Open Experiment Bookmark Close the experiment #1 and then double-click on bookmark in Make sure that correct experiment #1 is opened and correct

3.5 3) Bookmarks view event with bookmark is selected in events table Manual Pass
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3.6

3.7

Delete Bookmark (from
table)

Delete Bookmark (from
Bookmarks view)

BookmarksView

Make sure that bookmark icon is removed from event table
Select bookmarks icon in Events view, right-click on icon and select and corresponding bookmark is removed from the Bookmarks
"Remove Bookmark" view

Make sure that bookmark icon is removed from event table
Add a bookmark (see 6.4), then select bookmark in Bookmarks view, and corresponding Bookmark is removed from the Bookmarks
right mouse click and select "Delete". Confirm the deletion. view
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FiltersView

Section Pass Fail ToDo Comment

TME - Filters View 12 [ 12 [ o |1

Target: Ubuntu 14.10 64 bit

Step Test Case Action Verification Comment

Open a trace to be

1 filtered Trace is opened SWTBot SWTBot Pass

2 Open filter view Filter view is opened SWTBot SWTBot Pass
Create a filter on event  The filterview contains a filter on the event type and the

3 type and timestamp timestamp SWTBot SWTBot Pass

3.1 Apply that filter A subset of the events pass SWTBot SWTBot Pass

Create a filter on the
timestamp oring field

4 values Create the filter SWTBot SWTBot Pass
4.1 Apply that filter A subset of the events pass SWTBot SWTBot Pass
Create a filter with equals
5 node Create the filter SWTBot SWTBot Pass
5.1 Apply that filter A subset of the events pass SWTBot SWTBot Pass
Create a filter with
6 matches node Create the filter SWTBot SWTBot Pass
6.1 Apply that filter A subset of the events pass SWTBot SWTBot Pass
Create a filter with
7 contains node Create the filter SWTBot SWTBot Pass
71 Apply that filter A subset of the events pass SWTBot SWTBot Pass
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ColorsView

Section Pass Fail ToDo Comment

TMF - Colors View 6 n“ 0

Target: Ubuntu 14.10 64 bit

Step Test Case Action Verification Comment

1 Open a test trace a trace is visible in the events editor SWTBot SWTBot Pass

2 Open the colors view the view is visible SWTBot SWTBot Pass
Select a color and a filter, the matching events should update

3 Select a color and a filter their colors (background and foreground) to the new ones SWTBot SWTBot Pass

4 Add multiple colors Click on add 4 times, four colors should be displayed SWTBot SWTBot Pass
Change the color By clicking on up and down, the order of the displayed colors

5 priorities should change SWTBot SWTBot Pass

6 Delete all the colors The color filters should disappear. SWTBot SWTBot Pass
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HistogramView

Section Pass Fail ToDo Comment

TMF - Histogram View 50 n“ 5

Target: Ubuntu 14.10 64 bit

Step Test Case Action Verification Comment

1 Preparation
1.1 Step 1 Open and reset LTTng Kernel perspective LTTng Kernel perspective opens with correct views SWTBot Pass
1.2 Step 2 Open an LTTng trace Views are populated SWTBot Pass

2 Manage View

2.1 Close view Close the Histogram View Histogram View is removed from perspective Manual Pass
2.2 Open view Window > Show View > Other > Tracing > Histogram Histogram View is displayed and re-populated Manual Pass
2.3 Resize Resize the Histogram View width-wise Histograms are compressed/decompressed without loss  Manual Pass
3 Full Trace Histogram
3.1 Single selection Select timestamp with left-click Selection Start/End + blue bars are updated Manual Pass
Select time range with shift-left-click, shift-left-drag or left-
3.2 Range selection drag Selection Start/End + blue bars are updated Manual Pass
Drag the zoom window left/right with ctrl-left-drag or
3.3 Drag zoom window middle-drag Zoom window is dragged, won't go beyond full range Manual Pass
Zoom window is centered on click, won't go beyond full
34 Move zoom window Move the zoom window with ctrl-left-click or middle-click range Manual Pass
Zoom window is set, Window Span is updated, won't go
3.5 Set zoom window Set a new zoom window with right-drag beyond histogram range Manual Pass
Zoom window is updated, Window Span is updated,
3.6 Zoom in/out Zoom in/out with mouse wheel up/down won't go below 2 ns, won't exceed full trace range Manual Pass
Selection (blue bar) moves to the previous/next non-
3.7  Arrow keys Move the current event using left/right arrow keys empty bucket Manual Pass  arrow right doesn't work (Bug 468074) - fixed for Mars FIXED!
Selection Start/End moves to beginning/end of trace (i.e.
3.8 Home/End keys Press Home/End key start time of last bucket is selected) Manual Pass
With a trace containing lost events, click the "Hide lost
3.9 Lost events events" toolbar icon. Click it again. The lost events (red bars) are toggled on and off. Manual Pass
Zoom window is updated, Window Span is updated,
3.10  Zoom infout (key) Zoom in/out with +/- key won't go below 2 ns, won't exceed full trace range Manual Pass
4 Time Range Histogram
4.1 Single selection Select timestamp with left-click Selection Start/End + blue bars are updated Manual Pass
Select time range with shift-left-click, shift-left-drag or left-
4.2 Range selection rag Selection Start/End + blue bars are updated Manual Pass
Drag the zoom window left/right with ctrl-left-drag or
43 Drag zoom window middle-drag Zoom window is dragged, won't go beyond full range Manual Pass
Zoom window is updated, Window Span is updated,
4.4 Zoom in/out Zoom in/out with mouse wheel up/down won't go below 2 ns, won't exceed full trace range Manual Pass
Selection (blue bar) moves to the previous/next non-
4.5  Arrow keys Move the current event using left/right arrow keys empty bucket Manual Pass  arrow right doesn't work (Bug 468074) -> fixed - Fixed for Mars
Selection Start/End moves to beginning/end of time
4.6 Home/End keys Press Home/End key range (i.e. start time of last bucket is selected) Manual Pass
With a trace containing lost events, click the "Hide lost
4.7 Lost events events" toolbar icon. Click it again. The lost events (red bars) are toggled on and off. Manual Pass
Zoom window is updated, Window Span is updated,
3.10  Zoom in/out (key) Zoom in/out with +/- key won't go below 2 ns, won't exceed full trace range Manual Pass
5 Selection Start/End
5.1 Set selection start Enter a TS within the full range in Selection Start widget Selection Start + blue bars are updated Manual Pass
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52

53

5.4
55

6.1
6.2

6.3

71

7.2

73

7.4

8.1

8.2

8.3

8.4

9.1

9.2

9.3

9.4

10

Set selection end

Set selection (linked)

Set invalid selection start
Set invalid selection end

Window Span
Set window span
Set large window span

Set invalid window span

Selected Timestamp
Synchronization

Time Range mouse
synchronization

Full Trace mouse
synchronization

Selection synchronization
(linked)

External synchronization

Selected Time Range
Synchronization

Time Range mouse
synchronization

Full Trace mouse
synchronization

Selection Start/End
synchronization

External synchronization

Zoom Window
synchronization

Time Range mouse
synchronization

Full Trace mouse
synchronization

Window Span
synchronization

External synchronization

Multiple Trace
Synchronization

Preparation

Enter a TS within the full range in Selection End widget

Select the link icon. Enter a TS within the full range in
Selection Start widget

Enter a TS before the full range start in Selection Start
widget

Enter a TS after the full range end in Selection End widget

Enter a span in Window Span widget
Enter an invalid span (too large) in Window Span widget

Enter an invalid span (too small, negative, not a number) in
Window Span widget

Click on the time range histogram. The time of the bucket at

the mouse position is selected.

Click on the full trace histogram. The time of the bucket at
the mouse position is selected.

Select the link icon. Enter a time within the full range in
Selection Start widget

In any other view that supports time synchronization, select a

time.

Select a time range in the small histogram (shift-left click,
left-drag or shift-left drag).

Select a time range in the full histogram (shift-left click, left-

drag, shift-left drag).

Enter a time within the full range in Selection Start/End
widget

In any other view that supports time range synchronization,

select a time range.

Select a zoom window in the small histogram (ctrl-left drag,

middle-drag, right-drag, mouse wheel up/down).
Select a zoom window in the full histogram (ctrl-left drag,

middle-click, middle-drag, right-drag, mouse wheel up/down).

Enter a new span in Window Span widget

In any other view that supports range synchronization, select

a new zoom window.

1) Download traces.zip (if necessary) and unzip into a local

directory ${local}

2) Import kernel trace ${local}/traces/import/kernel-
overlap-testin

3) Import UST g{local}/traces/import/trace ust-overlap-
testing

4) Create experiment with trace of 2) in it

HistogramView

Selection End + blue bars are updated

Selection Start/End + blue bars are updated

Selection Start + blue bar set to first event
Selection End + blue bar set to last event

Both Histograms are updated accordingly
Span set to full range

Span set to previous value

Other views are synchronized to the selected time
Other views are synchronized to the selected time

Other views are synchronized to the selected time

Selection Start/End + blue bars in both histograms are
updated to the selected time

Verify that the selected time range shows in both
histograms, and in other views.

Verify that the selected time range shows in both
histograms, and in other views.
Other views are synchronized to the selected time range

Selection Start/End + blue bars in both histograms are
updated to the selected time range

Other views are synchronized to the new range
Other views are synchronized to the new range
Other views are synchronized to the new range

Wwindow Span and both histograms are updated to the
new range
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10.1

10.2

10.3

10.4

10.5

10.6
10.7

Open multiple traces (no
overlap) Open multiple traces that don't overlap in time

Change selected time and
range (no overlap)

Open multiple traces
(overlap)

Change selected time and
range (overlap)

Select a time and new range
Open multiple traces that overlap in time
Select a time and new range

Select other trace

(overlap) Select different trace by clicking its editor tab

With an experiment containing multiple traces opened, click
the "Activate trace coloring" toolbar icon. Click it again.

Trace coloring

Close all traces Close all trace editor tabs

HistogramView

View shows the last opened trace

Selection Start/End, Window Span and both histograms
are updated to selected time and new range.

View shows the last opened trace
Selection Start/End, Window Span and both histograms
are updated to selected time and new range.

View is updated to show selected trace. Selection
Start/End, Window Span and both histograms are set to
the newly selected time and range.

The colors in both Histograms and toggled on and off.
When it is toggled off, the legend disappears at the
bottom and only one color is used for non-lost events.

View is cleared.
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Section
TMF - Sequence Diagram

Target: Ubuntu 14.04 64 bit

Step

Test Case

Preparation

Open perspective

Open TMF Sequence
Diagram View

Create and open
experiment with
sequence diagram data

Manage View
Close view

Open view when
experiment/traces is
already loaded

Tooltip

Hover over interaction

Hover over interaction
after selection

Hover over time
compression bar

View Synchronization

Selection of interaction

Selection of event in
events table

Pass

Action

1) Download traces.zip (if necessary) and unzip into a local

directory ${local}

2 )Use traces simple-server-thread1 and simple-server-

thread2 under traces/import/ for test cases below

Open and reset LTTng Kernel perspective

Use menu Window — Show View - Other ... » Tracing »
Sequence Diagram

1) Create Tracing Project
2) Create Experiment (SeqExp)

3) Import 2 traces simple-server-thread1 and simple-server-

thread2

4) Select trace type "Generic CTF Trace"
5) Add these 2 traces to experiment

6) Open (double-click on) the experiment

Close Sequence Diagram view

1) Close 'Sequence Diagram' View
2) load sequence diagram experiment
3) Open Sequence Diagram view

1) Goto to first page (no selection of any interaction or
lifeline) 2) Hover over first interaction (arrow or number)

1) Goto to first page
2) select first interaction
3) Hover over 3rd interaction

Hover over first element in time compression bar on the left

of the view

Select an interaction in the 'Sequence Diagram'

Select an sequence diagram event in the events table (type

SEND or RECEIVE)

SequenceDiagram

Fail

Verification

LTTng Kernel perspective opens with correct views:
Project Explorer, Control, Control Flow, Resources,
Statistics, Histogram, Properties, Bookmarks

Verify that 'Sequence Diagram' view is shown

Verify that sequence diagram was loaded. The
interaction show the signal numbers (Note that trace
doesn't contain strings for the interactions. A special
parse)r would be necessary to map signal number to
trace

Sequence Diagram View is removed from perspective

Verify that sequence diagram was loaded. Verify that
all 17 pages are loaded.

Verify that tooltip appears with content with
interaction name and time stamp (10000
14:58:00.740995147)

Verify that tooltip appears with content with
interaction names and time stamp delta between
selected interaction and interaction that was hovered
over (10001 —» 10000 delta: 000.000 157 023)

Verify that tooltip appears with delta and graph to
show where delta is in relation to current configured
min max values. (delta: 000.000 3 480)

Verify that interaction is highlighted in 'Sequence
Diagram' view. Verify that in the events table the
corresponding event is selected. Verify that time
stamps matches

Verify that corresponding interaction is selected in the
'Sequence Diagram' view
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To Do

Comment

[ 2 [ o |5

Type

SWTBot

SWTBot

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Comment

Note: Ul tests are not SWTBot, but JUnit tests. Tests
are triggered programmatically right below the
dialogs level

Tooltip backgound is very dark and text is hard to read
on Ubuntu 13.10, 14.10 with default theme
https://bugs.eclipse.org/bugs/show_bug.cgi?id=45552
3



4.3

5.1

5.2

53

5.4

5.5

5.6

5.7

5.8

Selection of new time
range

View Actions

Test page navigation

Test menu item 'Pages...'

Find of interaction

Find of lifeline
Find criteria persistence

Find short-cut

Filter of interactions

Filter of lifelines

Change time range in 'Histogram View'.

Use buttons and menu items 'Go to next page', 'Go to
previous page', 'Go to last page' and 'Go to first page' to

navigate through trace. Use also menu item 'Pages...' to jump

to specific page

1) Select menu item 'Pages...'
2) In text box type “9”
3) Click on 'OK’

Goto to page 1~

1) Use button and menu item “Find”

2) select Interactions and deselect lifeline
3) type regular expression 10.*00

4) press find

5) press find

6) press find

7) press find

8) press find

Goto to page 1~

1) Use button and menu item “Find”

2) select lifeline and deselect interaction
3) type player2

4) press find

5) press find

1) Restart eclipse
2) open find dialog

1) Select 'Sequence Diagram' view
2) pres CTRL+F

Goto to page 1 -

1) Use menu item 'Hide Patterns...'

2) Press Add

3.1) select Interactions and deselect Lifeline
3.2) type regular expression 10.*03

4) Press 'Create’

5) Press 'Ok’

Goto to page 9 -

1) Use menu item 'Hide Patterns...'

2) Press Add

3.1) select Lifelines and deselect Interactions
3.2) type regular player2

4) Press 'Create’

5) Press 'Ok’

SequenceDiagram

Verify that the focus to the corresponding events of
the 'Sequence diagram' changes is changed.

Verify that different time ranges are selected when
changing page by looking at Histogram View.
Histogram View window will show the start of the
page. Note that there are 10000 interactions per page.
In this traces there are in total 160032 interactions.

?{':erli.Fy that last page has 32 interactions between 2
ifelines.

Verify that a dialog box will show. Verify that for this
trace it shows 'Total: 17 pages is shown” and the
current page is displayed in the text box. After step 3)
verify that page where changed to page 9. For this
trace page 9 is the page with 3 lifelines.

After 4) verify that interaction 10000 (player1 -
master) is selected. After 5) verify that interaction
10100 (master - player1) is selected. After 6) verify
that 10000 (player2 —» master) is selected. After 7)
verify that interaction 10100 (master - player2). After
8 nothing else will be found

After 4) verify that lifeline with name player2 is
selected (page 9 with 3 lifelines). After 5) player2 is
selected on page 10

Verify that previous used find criteria are still in the list

Verify that find dialog opens
After 5) verify that Interactions with name 10003 and

10103 are not shown

After 5) verify that player2 is not shown
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It's a bit unclear to me what this is supposed to do. |
think it means when the start of the range changes, it
should update the events shown in the sequence

Manual diagram

Manual

Manual

Manual

Manual
Manual

Manual

Manual

Manual




59

5.11

1) Apply one filter

2) Use menu item 'Hide Patterns...'
3) deselect filter

4) click 'Ok’

1) Restart eclipse
Filter criteria persistence 2) open hide dialog

Deselect filter

1) Use button and menu item for zoom-in to activate zooming

in
Zoom-in 2) click into sequence diagram view

1) Click on button and menu item 'Select' to go back to
selection mode

Selection after zooming 2) select an interaction

1) Use button and menu item for zoom-out to activate
zooming out

Zoom-out 2) click into sequence diagram view
1) Use button and menu item for 'Reset zoom factor' to reset
Reset zoom the zoom level

1) Select menu item 'Configure Min Max'
2) Change min to 100 and max to 2000 (keep scale and
precision)

Configure min/max 3) press 'Ok’

After changing min and max

1) select menu 'Configure Min Max'

2) press 'Default’ 3) press 'Ok’

Goto to page 1 -

1) Resize view so that the arrow of the interaction is not
shown

2) select on interaction

3) Use menu item Navigation —» Show node end

Configure min/max
(default)

Show node end

Goto to page 1 —»
1) Resize view so that the beginning of the interactions are
not shown
2) select on interaction
Show node start 3) Use menu item Navigation - Show node start
Goto to page 1 -
1) Resize view so that the arrow of the interaction is not
shown
2) select on interaction
Show node end short-cut 3) Press SHIFT+ALT+END

Goto to page 1 -
1) Resize view so that the arrow of the interaction is not
shown
2) select on interaction
Show node start short-cut 3) Press SHIFT+ALT+HOME

Scroll down short cut Press SHIFT+ALT+ARROW_DOWN

Scroll up short cut Press SHIFT+ALT+ARROW_UP

SequenceDiagram

Verify that all lifelines and interactions are shown
Verify that previous used hide criteria are still in the list

Verify that 'Sequence Diagram' view zooms in. Note
that no selection is possible.

Verify that selection is possible.

Verify that 'Sequence Diagram' view zoom out. Note
that no selection is possible.

Verify that 'Sequence Diagram' view goes back to
default zoom

After 1) verify that a dialog box shows with default
values. After 3) verify that time compression bar
changes some colors. It will show more deeper red
because the max value is lower.

After step 2) the default values are shown. After step
3) the time compression bar will change colors. Note
that the default values are computed based on all
deltas of 2 consecutive interactions.

Verify that end lifeline of the interaction (the arrow) is
shown

Verify that start lifeline of the interaction is shown

Verify that end lifeline of the interaction (the arrow) is
shown

Verify that start lifeline of the interaction is shown

Verify that within a page the display scrolls down per
view size

Verify that within a page the display scrolls up per view
size
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Key combination on Ubuntu 12.04 is used for
something else. This can be disabled using the
combiz-settings-manager
(http://askubuntu.com/questions/171489/how-to-
unbind-shift-alt-up-shortkey-in-12-04)

After disabling this combination this test case
passes

On Ubuntu 14.04, 14.10, this is not an issue, by
default the keys are not mapped.



5.27

Overview feature

Print

Remove filter (Bug
391714)

Time Sync. without

SequenceDiagram

Goto page 9 - Keep pressing + icon at the lowest right corner Verify that it's possible to navigate through a page of

of the view and drag down, up, left or right

Select 'Sequence Diagram' view and press printer icon in the
Eclipse's tool bar (or use CTRL+P). Select one pager page to
print

1) Create 1filter if necessary (see 5.8)

2) Open Error Log view if necessary

3) Open filter dialog box and remove all filters
4) Press 'Ok’

5) Open filter dialog box again

1) Open trace without any sequence diagram information
2) Open SD view if necessary

3) Open Error Log view if necessary

4) change time range in Histogram view

interactions (Bug 391716) 5) Change time current selected time in Histogram View

the sequence diagram view

Verify that it is possible to print

Verify that no exceptions occurred and after 5) no filter
are listed

Make sure that no exceptions occurred
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On Ubuntu, the movement is hectic and the overview
box is very narrow.

On Mac OS X 10.8, the button is not visible but there is
a visible empty space that is clickable in its place.
Clicking on it brings up the overview box which has a
reasonable size but movement is still hectic.

Bug 436442

Getting printer data on my Ubuntu 14.04 hangs
(Printer.getDefaultPrinterData() in SDPrintDialogUl)

Works on windows (including CTRL+P)



Section Pass
TMF - Statistics View 17

Target: Windows 7 64 bit

Step

Test Case Action

Preparation

Download traces simple-server-thread1 and simple-
Preparation server-thread1 from traces/import/

Open Perspective Open and reset LTTng Kernel perspective

Use menu Window - Show View - Other ... - Tracing -
Open TMF Statistics View Statistics

1) Create Tracing Project

2) Create Experiment (SeqExp)

3) Import 2 traces simple-server-thread1 and simple-server-
thread2

4) Select trace type "Generic CTF Trace"

Open experiment 5) Add these 2 traces to experiment

Manage View
Delete view Close the 'Statistics' View

Use menu Window - Show View - Other ... - Tracing -
Open view Statistics

Open view when
experiment/trace is

1) Close 'Statistics View' 2) load trace above trace 3) Open
already loaded i

'Statistics' view
Other
Build of statistic index Open trace

Open same trace multiple times after indexing of trace was
Persistence of statistics  finished the first time

Range Synchronization

External synchronization In any other view that supports range synchronization, select Events in selected time range' is updated and equals
'Events total' values

(Full) the full range of the trace.

External synchronization In any other view that supports range synchronization, select Events in selected time range' is updated according to
(range) anew range.

Multiple Trace

Synchronization

StatisticsView

Fail

Verification

LTTng Kernel perspective opens with correct views

Verify that 'Statistics' view is shown

Verify that statistics are shown per trace and per event
type. Each trace has 80021 events. Verify that event

types
ENTER/RETURN/SEND/RECEIVE/INFO/after_fork_child
are counted.

Statistics' view is removed from perspective

Statistics' view View is displayed and re-populated

Verify that statistics are shown per trace and per event
type. Each trace has 80021 events. Verify that event

types
ENTER/RETURN/SEND/RECEIVE/INFO/after_fork_child
are counted

Verify that 'Statistics' view is populated when indexing
is finished

Verify that when opening the trace the x-times (x > 1),
that the statistics appear right away without parsing
the trace again

new range
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ToDo Comment

[ 2 [ o |5

Type Comment

SWTBot Pass

SWTBot Pass Path is actually Window -> Show view -> Tracing -> Statistics

Manual Pass

Manual Pass

Manual Pass See comment on step 1.2 about the path
Randomly, the number of events in a trace stays at zero
when the statistics view is opened. However, | can't
reproduce the problem at will. Bug 436416
France : | have tried many times to open the view when
the trace is already loaded and was not able to redo the

Manual Pass  problem

Manual Pass The view is populated gradually during indexation

Manual Pass

Manual Pass

Manual Pass



5.1

5.2

5.3

5.4

5.5

5.6
5.7

Preparation

Open multiple traces (no
overlap)

Change selected time and
range (no overlap)

Select other trace (no
overlap)

Open multiple traces
(overlap)

Change selected time and
range (overlap)

Select other trace
(overlap)

Close all traces

StatisticsView

1) Download traces.zip (if necessary) and unzip into a local
directory ${local}

2) Import kernel trace ${local}/traces/import/kernel-
overlap-testin

3) Import UST g(local)/traces/import/trace ust-overlap-
testing

4) Create experiment with trace of 2) in it

Open multiple traces that don't overlap in time View shows the last opened trace
In any other view that supports range synchronization, select Events in selected time range' is updated according to
anew range new range

View is updated to show selected trace. 'Events in
selected time range' is updated according to the

Select different trace by clicking its Events editor tab selected trace's previously selected range.

Open multiple traces that overlap in time View shows the last opened trace

In any other view that supports range synchronization, select Events in selected time range'is updated according to
anew range new range

View is updated to show selected trace. 'Events in
selected time range' is updated according to the newly
Select different trace by clicking its Events editor tab selected time and range.

Close all Events editor tabs View is cleared.
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France : I am not sure what to do in this section (overlaping vs non
overlaping)



TimeChartView

Section Pass Fail Type ToDo Comment

TMF - Time Chart View 26 —“ 0

Target: Windows 7 64 bit

Step Test Case Action Verification Type Comment
1 Preparation
1.1 Preparation step 1 Open and reset LTTng Kernel perspective LTTng Kernel perspective opens with correct views. SWTBot Pass
1.2 Preparation step 2 Show Time Chart View Time Chart view is shown Manual Pass
2 Trace handling

Trace #1 entry added to Time Chart view. Trace #1 is
2.1 Open trace Open an LTTng CTF Kernel trace #1 selected entry. Range of view is full trace range. Manual Pass

Trace #2 entry added to Time Chart view. Trace #2 is
selected entry. Range of view is union of full trace
2.2 Open other trace Open an LTTng CTF Kernel trace #2 ranges. Manual Pass

Experiment entry added to Time Chart view.
Experiment is selected entry. Range of view is union of

2.3 Open experiment Open an experiment full trace ranges. Manual Pass
Trace #1 is selected entry. View range does not change.

2.4 Select other trace Select trace #1 by clicking its trace entry in Time Chart view  Trace #1 editor tab is brought to top. Manual Pass

Select other trace

2.5 (external) Select trace #2 by clicking its editor tab Trace #2 is selected entry. View range does not change. Manual Pass

2.6 Close view Close the Time Chart view Time Chart view is removed from perspective Manual Pass
Time Chart view is displayed and re-populated with

2.7 Open view Show Time Chart view opened traces data Manual Pass
Trace entry is removed from Time Chart view. Range is

2.8 Close trace/experiment  Close trace #2 editor tab. Repeat with experiment editor tab. view is union of remaining full trace ranges. Manual Pass

2.9  Close last trace Close trace #1 editor tab View is cleared. Manual Pass

3 Time Synchronization

Other views are synchronized to the selected time.
Mouse synchronization Event at or following the selected time is selected in
3.1 (single time) Left-click on the time chart. The selected time line is updated. the event table. Manual Pass

Other views are synchronized to the selected range.
Mouse synchronization  Shift-left-click or left-drag on the time chart. The selected Event at or following the selected time is selected in

3.2 (time range) time range is updated. the event table. Manual Pass
External synchronization Selected time line is updated to the event time. If

33 (single time) In event table, select an event. necessary, range is updated to show selected time. Manual Pass
External synchronization

34 (time range) In event table, select an event range with shift-left-click. Selected time line is updated to the time range. Manual Pass
Zoom Range

4 Synchronization

Mouse wheel

4.1 synchronization Zoom in/out with mouse wheel while holding Ctrl. Other views are synchronized to the new range Manual Pass
Mouse drag zoom

4.2 synchronization Drag zoom with right-button on time chart. Other views are synchronized to the new range Manual Pass
Mouse drag move

4.3 synchronization Drag move with ctrl-left or middle button on time chart. Other views are synchronized to the new range Manual Pass



4.4

4.5

5.1
5.2
53
5.4

5.5
5.6

Mouse full range
synchronization

External synchronization

Event Table
Synchronization

Search synchronization
Search cleared

Filter synchronization
Filter cleared

Bookmark
synchronization

Bookmark cleared

Double-click with left button on time chart's time scale.

In any other view that supports range synchronization, select
anew zoom range.

Enter a search regex in event table
Clear the search regex in event table
Enter a filter regex in event table
Clear the filter regex in event table

Add a bookmark in event table
Remove the bookmark in event table

TimeChartView

Other views are synchronized to the full range

View range is updated to the new range

Matching events are marked in time chart

Marks are removed in time chart

Non-matching events are removed from time chart
All events are shown in time chart

Bookmarked event is marked in time chart
Mark is removed in time chart
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Manual

Manual
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Custom Parsers

Section Pass Fail
TMF - Custom Parsers 27

Target: Windows 7

Step Test Case Action Verification
0 Prerequisites
0.1  Get custom parser definition and logs Find text and XML test files.
1 View management
Open and reset Tracing perspective, and
1.1 Open perspective open Time Chart view Time Chart view opens.
Create a tracing project and import a text
1.2 Import traces and XML custom trace Traces imported in Traces folder of project.
2 Custom parser management
Open Manage Custom Parsers dialog in
2.1 Open Manage Custom Parsers dialog Traces folder context menu Dialog opens.
Select "Text" radio button, click New...
button, enter Trace type, change stuff,
2.2 New (text) click Next, click Finish Custom parser appears in list.
Select custom parser, click Edit..., Previously entered data appears, can be
2.3  Edit (text) change stuff, click Next, click Finish edited.
Select custom parser, click Export, enter
2.4  Export (text) name, click Save Exported custom parser stored in file system.
2.5 Delete (text) Select custom parser, click Delete Custom parser is deleted.
Click Import, find custom parser
2.6  Import (text) definition, click Open Imported custom parser appears in list.
Select "XML" radio button, click New...
button, enter Log Type, write an xml log
in the input,
<a><b><c>1</c><d>1</d></b><b><c>2<
/c><d>1</d></b></a> then click on
feeling lucky. set c to timestamp logged
and d to message logged, set timestamp
format to ss in both text boxes, click Next,
2.7 New (XML) click Finish Custom parser appears in list.
Select custom parser, click Edit..., Previously entered data appears, can be
2.8  Edit (XML) change stuff, click Next, click Finish edited.
Select custom parser, click Export, enter
2.9  Export (XML) name, click Save Exported custom parser stored in file system.
2.10 Delete (XML) Select custom parser, click Delete Custom parser is deleted.
Click Import, find custom parser
211 Import (XML) definition, click Open Imported custom parser appears in list.
3 Custom parser trace handling
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Type To Do
5 0

Type
Manual Pass
Manual Pass
SWTBot Pass
SWTBot Pass
SWTBot Pass
Manual Pass
SWTBot Pass
Manual Pass
Manual Pass
Manual Pass
Manual Pass
SWTBot Pass
Manual Pass

Comment
1

Comment

New Custom Parser dialog is very tall on GTK3



3.1

3.2
3.3

3.4

35

3.6
3.7

3.8

4.1

4.2

4.3

44

4.5

4.6

Select trace type (text)

Open trace (text)
Raw view (text)

Time synchronization (text)

Select trace type (XML)

Open trace (XML)
Raw view (XML)

Time synchronization (XML)

Raw viewer

Show Raw Viewer
Hide Table

Show Table
Select Event (Bug 457852)
Select Event using arrow keys

(457852)

Hide Raw viewer

Select test file in Traces folder, right-click,

Custom Parsers

select "Select Trace Type > Custom Text Trace type is assigned (re-open Select Trace

> (parser name)"

Double-click on test file in Traces folder
Right-click in editor, click Show Raw

Click in Time Chart view, select event in
editor table, select event in raw view

Select test file in Traces folder, right-click,

Type sub-menu to verify)

Editor opens with events table, Time Chart
view is populated.

Editor is split with raw view on right pane.

All three widgets synchronize to selected
time.

select "Select Trace Type > Custom XML Trace type is assigned (re-open Select Trace

> (parser name)"

Double-click on test file in Traces folder
Right-click in editor, click Show Raw

Click in Time Chart view, select event in
editor table, select event in raw view

1) Open Custom text trace
2) Right-click in table and select "Show
Raw"

Right-click in table and select "Hide
Table"

Right-click in table and select "Show
Table"

Select event in raw viewer

1) select event in raw viewer with mouse
2) use arrow key down and up several
times

Right-click in table and select "Hide Raw"

Type sub-menu to verify)

Editor opens with events table, Time Chart
view is populated.

Editor is split with raw view on right pane.

All three widgets synchronize to selected
time.

Raw viewer is shown beside the events table

Events table is hidden and only raw viewer is
shown

Events table is shown beside raw viewer

Correct event is select in table, timestamp is
propagated to other TMF views and
Properties view shows content of selected
event

Correct event is select in table, timestamp is
propagated to other TMF views and
Properties view shows content of selected
event

Raw viewer is hidden and only events table
is shown
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State System Explorer

Section Type ToDo Comment

TMEF - State System Explorer
Target: Windows 7 64 bit

Action ati J Comment

1 Preparation

Open TMF State System Explorer  Use menu Window — Show View — Other ... — Tracing —
1.1  View State System Explorer Verify that 'State System Explorer' view is shown Manual | Pass

2 Manage View
2.1  Delete view Close the State System Explorer' View 'State System Explorer' view is removed from perspective Manual | Pass

Use menu Window — Show View — Other ... — Tracing —
2.2 Open view State System Explorer 'State System Explorer' view is displayed and re-populated Manual | Pass
Verify that view is populated with kernel state system
(o.e.t.analysis.os.linux.kernel) and statistics state systems (o.e.l.tmf.statistics.*)
2.3 Open Trace Open an LTTng Kernel Trace of opened trace Manual | Pass  Some state systems ID's should be renamed for Trace Compass

1) Close State System Explorer View
Open view when trace is already 2) Load LTTng trace
2.4 loaded 3) Open 'State System Explorer' view Verify that view is populated with state systems from trace Manual | Pass (if the state system were already built)
The values are only available for time ranges where the trace

s . . . L. exists. Only after we've "visited" other timestamps, then the
Verify that view is populated with all kernel state system and statistics state attributes s{mw up and print "Out of range"" P

2.5  Open Experiment Open Experiment with 2 or more LTTng traces systems of opened experiment (separated by trace) Manual | Pass  http://eclip.se/443653

View is updated to show selected trace. State values, start time and end time are

2.7 Select other trace Select different trace by clicking its Events editor tab updated according to the selected trace's previously selected range. Manual | Pass
2.6 Restart Restart Eclipse Verify that view is populated with state systems from trace Manual | Pass
2.7  Close all traces Close traces and experiment one by one from the editor tab Verify that state system explorer view is cleared after closing the last trace Manual | Pass

Timestamp / Time Range
3 Selection

Select time in another view (e.g Histogram view) that supports

3.1  Select timestamp time synchronization Verify that state values are updated Manual | Pass
Select a time range in another view that supports time Verify that only the start of the range is taken in consideration (changing the
3.2 Select time range synchronization end time of the range should not affect the displayed values) Manual | Pass

4 Displaying of Changed Values
Attributes whose value changed in the last timestamp selection should be

4.1  Highlighting of changed values Select many different timestamps one after the other highlighted in yellow. Manual | Pass
“Only Display Changes at Selected
Timestamp” option with event Enable the “Only Display Changes...” option with the toolbar ~ Verify that only the state values that changed because of that event are
4.2 selection button. Select different Events from the Event Table. displayed. Manual | Pass
Enable the “Only Display Changes...” option. Select
“Only Display Changes...” with *timestamps* corresponding to state changes (for example,
timestamp selection using the previous/next buttons in the Control Flow View). Verify that only the state values that changed at that timestamp are displayed. Manual | Pass
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Section
TMEF - Call Stack View

Target: Windows 7 64 bit

Step  Test Case

1.2

1.3
1.4

2
2.1

22
23

24

25
2.7
2.6

2.7

3.2
33
34

4.1

42
43

Download the test resources

Preparation
Open TMF Call Stack View

Import generic trace

Import cyg-profile trace
Import cyg-profile-fast trace

Manage View

Delete view

Open view

Open Trace

Open view when trace is already loaded

Open Experiment
Select other trace
Restart

Close all traces

Navigation

Select time

Select Previous/Next Event
Zoom to function (table)

Zoom to function (time graph)

Synchronization

Time synchronization

Event synchronization

Time range synchronization

Action

Download this

Use menu Window — Show View — Other ... — Tracing —
Call Stack

Import a trace that does not have any call stack information, like

a standard kernel trace

Import the trace in the "trace" directory of the downloaded zip

Import a trace in the "trace-fast" directory of the downloaded zip

Close the Call stack view' View

Use menu Window — Show View — Other ... — Tracing —
Call Stack

Open "trace(-fast)" trace

1) Close 'Call Stack' view

2) Open "glxgears-cyg-profile(-fast)" trace located in the git in
ctf test

3) Open 'Call Stack' view

Open Experiment with 2 or more Call Stack traces.
(You can use both traces)

Select different trace by clicking its Events editor tab

Restart Eclipse with Call Stack trace opened

Close traces and experiment one by one from the editor tab

Click on random time in the time graph pane

Click Previous/Next Event button
Double-click on a function in the table pane

Double-click on a function (interval) in the time graph pane

Select a random time in another view

Select a call stack-impacting event (function entry/exit) in events

table

Select a new time range in Histogram view.

Call Stack View

Fail

Verification

Verify that 'Call Stack' view is shown

Verify that nothing is shown in the view, except “Stack info not available
(<tracename>)"

Verify that the Callstack View is populated with some callstack information.

Verify that the Callstack View is populated with some callstack information.

'Call Stack' view is removed from perspective

'Call Stack' view is displayed and re-populated

Verify that view is populated with call stack information

Verify that view is populated with call stack information

Verify that view is populated with all call stack information (separated by
trace).

View is updated to show selected trace.

Verify that view is populated with call stack from trace

Verify that Call Stack view is cleared after closing the last trace

Selected time line is updated. Table is updated to show the full stack
information at the selected time. Selected time is updated in other views.

Previous or next call stack change is selected and corresponding active function
and stack depth is selected. Table is updated to show the full stack information
at the selected time. Selected time is updated in other views.

Time range is updated to the full duration of the selected function

Time range is updated to the full duration of the selected function

Selected time line is updated. Table is updated to show the full stack
information at the selected time. If selected time is outside current range, time
range is updated to include it.

In addition to updating the selected time, the active function at the event time is
selected. Vertical scroll bar is updated if necessary.

Time range is updated.
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To Do Comment

Pass

Pass

Pass

Pass

Pass

Pass
Pass

Pass

Pass
Pass

Pass

Pass

Pass

Pass
Pass

Pass

Pass

Pass

Pass

Comment

Path is actually Window -> Show view -> Tracing -> Call stack

See comment 1.1. about the path

The vertical scroll bar is not updated

The vertical scroll bar is not updated


https://drive.google.com/file/d/0BxUCnNTRLr5pWUdXd0JJV3hyeEk/edit?usp=sharing

5.1  Invalid text file import

Click the "Import a textfile..." button in the view. Select a
random file that does not contain any debugging info.

Call Stack View

The function addresses do not change.

France : T am not sure what to do here

5.2 Valid text file import

Import a file "fibonacci.symbols"

The view now displays function names instead of function addresses (both in
the timegraph and the call stack areas).

The symbol mapping is applied on view level. If multiple traces
are opened, or if an experiment with multiple traces is opened,
they cannot each have their own mapping. Bug 459909.

France : I am not sure what to do here

Binary import

Click the "Import Binary..." button in the view, select the
fibonacci executable (fibonacci)

The view now displays the function names for both traces
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France : I am not sure what to do here




Target:

Step

2.1
2.2

3.1

3.2

3.3

3.4
3.5
3.6
3.7
3.8

4.1

4.2

4.3

44

v

5.1
5.2

5.3

5.4

5.5
5.6

5.7

Section
TMF - Remote Fetching

Test Case

Preparation

Step 1
Opening
Open Profile Editor 1
Open Profile Editor 2
Edit Profile - Add/Delete

Create Profile
Add Node
Add trace group

Add trace

Delete Trace

Delete Trace Group
Delete Connection Node
Remove Profile

Edit Profile - Reorder
Move profile up/down
Move connection node
up/down

Move Trace Group up/down

Move Trace up/down

Edit Profile - Copy, Cut, Paste

Copy/Paste Profile
Copy/Paste Profile (Keys)

Copy/Paste Connection Node

Copy/Paste Connection Node
(Keys)

Copy/Paste Trace Group

TMF - Remote Fetch

Action

Open Trace Compass and reset Lttng perspective

Right-click on Traces Folder -> Fetch Remote Traces ... ->
Manage Profiles

window -> Preferences-> Tracing -> Remote Profiles

Open Profile Editor > Click on 'Add' > Enter profile name,
remote information, root path and trace pattern

Select Profile node > right mouse click > select 'New
Connection Node'

Select node node > righ mouse click > select 'New Trace
Group'

Select trace group > right mouse click > select 'New Trace'
Select trace > right mouse click > select Delete

Select Trace Group> right mouse click > select Delete
Select Connection Node > right mouse click > select Delete
Select Profile > click on 'Remove' button

Create at 2-3 profiles > select 2nd profile and press buttons
'Move Up'/'Move Down'

Make sure that there are 2 or 3 connection nodes > select 1
connection node > click buttons 'Move Up'/'Move Down'
Make sure that there are 2 or 3 trace gropus > select 1 trace
gropu > click buttons 'Move Up'/'Move Down'

Make sure that there are 2 or 3 trace gropus > select 1 traces

> click buttons 'Move Up'/'Move Down'

Select Profile > click right mouse button on a profile > Select

Copy -> click right mouse button on other profile > Select
Paste

Redo 5.1 with CTRL+C and CTRL+V keys

Select Profile > click right mouse button on a Connection
Node > Select Copy -> click right mouse button on other
Connection Node > Select Paste

Redo 5.3 with CTRL+C and CTRL+V keys
Select Profile > click right mouse button on a Trace Group >

Select Copy -> click right mouse button on other Trace Group

> Select Paste

Copy/Paste Trace Group (Keys) Redo 5.5 with CTRL+C and CTRL+V keys

Copy/Paste Trace

Select Profile > click right mouse button on a Trace > Select
Copy -> click right mouse button on other Trace > Select
Paste

Fail

Verification

Lttng perspective opens with correct views

The Profile Editor of preference page opens
The Profile Editor of preference page opens

New Profile is created and template is provided

New Connection Node is create under the profile and
template is provided

New Trace Group is created under the node and template
is provided

New Trace is created under Trace Group and template is
provided

Trace is deleted

Trace Group is deleted
Connection Node is deleted
Profile is deleted

Profiles are moved up and down

Connection Nodes are moved up and down within a profile
Tre:jce Groups are moved up and down within a connection
node

Traces are moved up and down within a Trace Group

Profile is pasted under the selected profile
Profile is pasted under the selected profile

Profile is pasted under the selected Connection Node

Profile is pasted under the selected Connection Node

Profile is pasted under the selected Trace Group
Profile is pasted under the selected Trace Group

Profile is pasted under the selected Trace
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To Do
0

SWTBot
SWTBot

SWTBot
SWTBot
SWTBot

SWTBot
SWTBot
Manual
Manual
SWTBot

Manual
Manual
Manual

SWTBot

Manual
Manual

Manual

Manual

Manual
Manual

SWTBot

Pass
Pass

Pass
Pass
Pass

Pass
Pass
Pass
Pass
Pass

Pass

Pass

Pass

Pass

Pass
Pass

Pass

Pass

Pass
Pass

Pass

Comment
7

Comment




5.8
5.9

6.1
6.2

6.3

6.4
6.5

6.6
6.7
6.8
6.9

7.1
7.2

73

8.1

8.2

8.3

Copy/Paste Trace (Key)
Cut/Paste

Edit Profile - Adverserial
Error empty profile name
Duplicate profile name

Error empty Connection node

name

Duplicate Connection node
name

Missing username in URI

Invalid URI

Error empty Trace Group
Error empty Trace
Invalid File pattern

Export/Import Profile

Export Profile
Import Profile

Import Profile

Remote Fetch Wizard

Preparation

Create and run Profile "new

TMF - Remote Fetch

Redo 5.5 with CTRL+C and CTRL+V keys
Redo 5.1 - 5.8 with cut and paste

Clear profile name
Add profile with name of existing profile

Clear Connection node name

Wi(tjhin a profile, add Connection node with name of existing
node

remove user name of a Connection Node

add invalid URI

Delete Trace Group name

Delete File Pattern

Add trace with invalid regular expression

Select multipe profiles > Click Export Button > Select Folder
and enter file name > OK

Click on Import Button > select profile XML file > OK

Redo 7.2

1) Import Test Profiles (test-profiles.xml) from test spec.
template directory

2) Edit profiles in Fetch Remote Traces > Manage profiles
3) Change 'user' and '127.0.0.1' for all connection nodes if
necessary

3) Extract traces.zip from test spec. template directory in

tmp
4) Load custom text parsers located in traces.zip
(traces/customParsers)

1) Create traces in /tmp/traces/syslog and
/tmp/traces/generated/synthetic-trace

2) Create Profile with Local connection, 1 trace group (root
/tmp/traces/) and 2 traces (.*syslog.* and .*synthetic.*) in
this group

3) Select profile in Fetch Remote Traces wizard (Remote
Profile page)

Profile" (syslog + synthetic CTF 4) Click on 'Next' button

trace in sub-directory)
Clear traces

Create and run Profile "new

5) Click on 'Finish’
Delete all traces from Traces directory

1) Create traces in /tmp/traces/syslog and
/tmp/traces/generated/synthetic-trace

2) Create Profile with Local connection, 1 trace group (root
/tmp/traces/) and 2 traces (.*syslog.* and .*synthetic.*) in
this group

3) Select profile in Fetch Remote Traces wizard (Remote
Profile page)

Profile" (syslog + synthetic CTF 4) Click on 'Next' button

trace in sub-directory), only 1

trace selected
Clear traces

5) deslect the synthetic CTF trace
5) Click on 'Finish’

Delete all traces from Traces directory

Profile is pasted under the selected Trace

Successful cut and paste

Error message "Profile must not be empty"
Error message "Duplicate profile name"

Error message "Node name must not be empty"

Error message "Duplicate node names"

Error message "URI must include user information"

Error message "URI must include valid host and port
number"”

Error message "Trace Group name must not be empty"
Error message "File name must not be empty"

Error message "Invalide File Pattern"

Only selected profiles are exported

Profiles are emported

after second import an error message appears "Duplicate
profile names"

Verify that all test traces are imported with correct trace
types assigned. Verify that folder structure is preserved.

All traces deleted

Verify that only the selected traces are imported with

correct trace types assigned. Verify that folder structure is

preserved.
All traces deleted
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SWTBot
SWTBot

Manual

SWTBot

SWTBot

Trace (5.7) is done with SWTBot

Local connection is used in SWTBot

Local connection is used in SWTBot



8.4

8.5

8.6

8.7

8.8

8.9

8.11

8.14

Run Profile "TestAllRecursive"

Re-run Profile
"TestAllRecursive" (Rename)

Re-run Profile
"TestAllRecursive"
(Overwrite)

Re-run Profile
"TestAllRecursive" (Skip)

Re-run Profile
"';'estAllRecursive" (Overwrite
2

Clear traces

Re-run Profile
"TestAllRecursive" (2)

Clear traces

Run Profile
"TestAllNonRecursive

Clear traces

Run Profile
"TestSpecificRecursive"

Clear traces

Run Profile
"TestSpecificNonRecursive"

Clear traces
Run Profile

"TestSpecificMutliGroupRecur
sive"

Clear traces

Cancel Import

TMF - Remote Fetch

1) Select profile "TestAllRecursive" in Fetch Remote Traces
wizard (Remote Profile page)

2) Click on 'Next' button (enter password if needed)

3) Click on 'Finish’

1) Select profile "TestAllRecursive" in Fetch Remote Traces
wizard (Remote Profile page)

2) Click on 'Next' button (enter password if needed)

3) Click on 'Finish’

4) In dialog box select 'Rename’ for the first trace and
'Rename ALL' for the second traces

1) Select profile "TestAllRecursive" in Fetch Remote Traces
wizard (Remote Profile page)

2) Click on 'Next' button (enter password if needed)

3) Click on 'Finish’

4) In dialog box select 'Overwrite' for the first trace and
'Overwrite ALL' for the second traces

1) Select profile "TestAllRecursive" in Fetch Remote Traces
wizard (Remote Profile page)

2) Click on 'Next' button (enter password if needed)

3) Click on 'Finish’

4) In dialog box select 'Skip' for the Ffirst trace and "Skip ALL'
for the second traces

1) Select profile "TestAllRecursive" in Fetch Remote Traces
wizard (Remote Profile page)

2) Select checkbox 'Overwrite traces without warning'

3) Click on 'Next' button (enter password if needed)

4) Click on 'Finish'

Delete all traces from Traces directory

1) Select profile "TestAllRecursive" in Fetch Remote Traces
wizard (Remote Profile page)
2) Click on 'Finish' (enter password if needed)

Delete all traces from Traces directory

1) Select profile "TestAllNonRecursive" in Fetch Remote
Traces wizard (Remote Profile page)

2) Click on 'Next' button (enter password if needed)

3) Click on 'Finish’

Delete all traces from Traces directory

1) Select profile "TestSpecificRecursive" in Fetch Remote
Traces wizard (Remote Profile page)

2) Click on 'Next' button (enter password if needed)

3) Click on 'Finish’

Delete all traces from Traces directory

1) Select profile "TestSpecificNonRecursive" in Fetch
Remote Traces wizard (Remote Profile page)

2) Click on 'Next' button (enter password if needed)
3) Click on 'Finish’

Delete all traces from Traces directory

1) Select profile "TestSpecificMultiGroupRecursive" in Fetch
Remote Traces wizard (Remote Profile page)

2) Click on 'Next' button (enter password if needed)

3) Click on 'Finish’

Delete all traces from Traces directory

1) Select profile "TestAllRecursive" in Fetch Remote Traces
wizard (Remote Profile page)

2) Click on 'Next' button (enter password if needed)

3) Click on 'Finish’

4) Cancel import (red square or Cancel button)

Verify that all test traces are imported with correct trace
types assigned (LTTng kernel, LTTng UST, custom text,
custom XML). The file unrecognized.log is importeds with
unrecognized trace type. Make sure that directory
structure is preserved.

Verify that all test traces are imported with new name and
correct trace types assigned (LTTng kernel, LTTng UST,
custom text, custom XML). The file unrecognized.log is
importeds with unrecognized trace type. Make sure that
directory structure is preserved.

Verify that all test traces are imported with correct trace
types assigned where old traces are overwritten. (LTTng
kernel, LTTng UST, custom text, custom XML). The File
unrecognized.log is importeds with unrecognized trace
type. Make sure that directory structure is preserved.

Verify that all test traces are skipped and no trace is
imported
Verify that all test traces are imported with correct trace
types assigned where old traces are overwritten (no

ialog box opens). (LTTng kernel, LTTng UST, custom text,
custom XML). The file unrecognized.log is importeds with
unrecognized trace type. Make sure that directory
structure is preserved.

All traces deleted

Verify that all test traces are imported with correct trace
types assigned. The second page is omitted. (LTTng
kernel, LTTng UST, custom text, custom XML). The Ffile
unrecognized.log is importeds with unrecognized trace
type. Make sure that directory structure is preserved.

All traces deleted

Verify that only traces from root path are imported

(LTTng kernel, LTTng UST, custom text, custom XML). The
file unrecognized.log is importeds with unrecognized trace
type. Make sure that directory structure is preserved.

All traces deleted

Verify that only kernel and custom text logs are imported
from root and subdirectory. Make sure that directory
structure is preserved.

All traces deleted

Verify that only kernel and custom text logs are imported
from root directory only. Make sure that directory
structure is preserved.

All traces deleted

Verify that only traces from root path are imported

(LTTng kernel, LTTng UST, custom text, custom XML). The
file unrecognized.log is importeds with unrecognized trace
type. Make sure that directory structure is preserved.

All traces deleted

Verify that import operation is cancelled
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Profile has trace type 'Generic CTF Trace' but
trace imported as 'Linux Kernel Trace'

Profile has trace type ‘Generic CTF Trace' but
trace imported as 'Linux Kernel Trace'

Profile has trace type 'Generic CTF Trace' but
trace imported as 'Linux Kernel Trace'



8.15

9.1

9.2

10

Clear traces

Run Profile "TestMultiNodes"

Connection Handling

Error cannot connect to
remote host (node doesn't
exist)

Error cannot connect to

TMF - Remote Fetch

Delete all traces from Traces directory

1) Select profile "TestMultiNodes" in Fetch Remote Traces
wizard (Remote Profile page)

2) Click on 'Next' button (enter password if needed)

3) Click on 'Finish’

Create profile with IP address that cannot be connected to
and run profile

Create profile valid IP address. When asked for password

remote host (wrong password) enter invalid password

Other Remote Backends
Clear traces

Remote Fetch using Local

Delete all traces from Traces directory

Create profile (see 7.3) with URI scheme file (instead of ssh)
and node name Local and redo test 7.3

All traces deleted

Verify that only traces from root path are imported

(LTTng kernel, LTTng UST, custom text, custom XML). The
file unrecognized.log is importeds with unrecognized trace
type. Make sure that directory structure is preserved. 2

nodes directories are created with the above traces stored Manual

Operation to connect to remote node fails and error dialog
is shown with detailed information (after time-out)
Operation to connect to remote node Ffails with time-out
and error dialog is shown with detailed information. Note
time-out is as per remote development preferences

Manual

Manual

All traces deleted

Verify that all test traces are imported with correct trace
types assigned (LTTng kernel, LTTng UST, custom text,
custom XML). The file unrecognized.log is importeds with
unrecognized trace type. Make sure that directory

structure is preserved. SWTBot

41

See tests 7.2/7.3



LTTng 2.0 - ControlFlowView

Section To Do Comment
LTTng 2.0 - Control Flow View

Target: Windows

Step Test Case Action Verification Comment
0 Prerequisites
Import LTTng Kernel traces in Tracing
0.1 Import traces project
Create an experiment with LTTng Kernel
0.2 Create experiment traces
1 View management

1.1 Open perspective Open and reset LTTng Kernel Perspective  Control Flow view opens. SWTBot Pass

Control Flow view is populated with
processes, sorted by Trace then TID. Child
processes appear under their parent, sorted
by birth time. Range is set to initial offset.
1.2 Open trace Open LTTng Kernel trace in Project Explorer Arrows are drawn between states of a CPU. Manual Pass Incorrect birth times. Bug 476481. Fix included in release.

Control Flow view is populated with

processes, sorted by Trace then TID. Child

processes appear under their parent, sorted
Open experiment with LTTng Kernel traces by birth time. Range is set to initial offset.

1.2 Open experiment in Project Explorer Arrows are drawn between states of a CPU. Manual Pass

1.3 Close view Close the Control Flow view View is closed. Manual Pass
Control Flow view is opened and populated

1.4 Open view Open the Control Flow view with processes. Manual Pass

2 View selection

21 Select process in table Select a process in the table Same process is highlighted in time graph. Manual Pass

Same process is highlighted in table.
Select a process in the time graph (empty ~ Selected time line is updated. Other views
2.2 Select process in time graph region) are synchronized to selected time. Manual Pass

Same process is highlighted in table. State is
highlighted in time graph. Selected time line
is updated. Other views are synchronized to
2.3 Select state in time graph Select a state in the time graph selected time. Manual Pass

3 Mouse handling

Time range is dragged. When mouse button
Ctrl-Drag move time graph left and right with is released, states are updated and new time
3.1 Drag move time range middle button range is propagated to other views. Manual Pass

Time range is zoomed in and out, relative to

Zoom with mouse wheel up and down, mouse cursor. When mouse wheel is stopped
cursor inside time graph while holding the Ctl for a short time, states are updated and new
3.2 Zoom time range (mouse wheel) button time range is propagated to other views. Manual Pass

Time range is zoomed in and out. When
mouse button is released, states are updated
Drag in time graph scale left and right with  and new time range is propagated to other
3.3 Zoom time range (mouse drag) left button views. Manual Pass
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3.4

3.5

3.6

3.7

3.8

3.9

3.10

3.1

4.1

4.2

4.3

4.4

5.1

Mouse vertical scroll

Vertical scroll bar

Drag select time range

Double-click reset time range

Mouse hover (empty region)

Mouse hover (state)

Drag mouse selection

Shift key selection
Keyboard handling

Keyboard navigation in table
(process selection)

Keyboard navigation in table (tree
expansion)

Keyboard navigation in time graph
(process selection)

Keyboard navigation in time graph
(state selection)

Tool bar handling

Show Legend

Scroll with mouse wheel up and down,
cursor outside time graph

Click and drag vertical scroll bar

Drag select time graph with right button

Double-click left button on time scale

Hover mouse in time graph over empty
region

Hover mouse in time graph over state

Drag select time graph with left button

Click select with left button (begin time),
press shift key and click select another time
(end time)

With focus on table, use UP, DOWN, HOME,
END keys

With focus on table,
in Windows use LEFT, RIGHT keys while
parent or child process is selected

in Linux use SHIFT LEFT, RIGHT keys while
parent or child process is selected

With focus on time graph, use UP, DOWN,
HOME, END keys

With focus on time graph, use LEFT, RIGHT
keys

Click Show Legend button

LTTng 2.0 - ControlFlowView

Table and time graph scroll up and down and
remain aligned. Selected process does not
change. Vertical scroll bar updated.

Table and time graph scroll up and down and
remain aligned. Selected process does not
change.

Selection highlighted. When mouse button is
released, time range is zoomed to selection,
states are updated and new time range is
propagated to other views.

Time range is reset to full range, states are
updated and new time range is propagated to
other views.

Tool tip shows process name only.

Tool tip shows process name, state name,
date, start time, end time, duration. For
USERMODE state, CPU is shown. For
SYSCALL state, CPU and System Call is
shown. For INTERRUPTED state, CPU is
shown.

Selection highlighted. Status bar of Eclipse is
updated with time information: T, T1, T2 and
delta, where T is the time of the mouse
position, T1 the left most selected time, T2
the right most selected time and delta the
time difference between T2-T1

Selection highlighted. Status bar of Eclipse is
updated with time information: T, T1, T2 and
delta, where T is the time of the mouse
position, T1 the left most selected time, T2
the right most selected time and delta the
time difference between T2-T1

Selected process is changed. Time graph
selection is updated. Vertical scroll bar
updated.

For parent process, tree is expanded or
collapsed. Time graph item expansion is
updated. Vertical scroll bar updated. For child
process, left changes selection to parent,
time graph selection is updated. Vertical
scroll bar updated.

Selected process is changed. Table selection
is updated. Vertical scroll bar updated.

Previous or next state is selected. Selected
time is updated in other views.

The legend dialog is opened and can be
closed.
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Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

SWTBot

Manual

Tested in Windows



5.2

5.3

5.4

5.5
5.6

5.7

5.8

5.9

5.10

6.1

6.2

6.3

6.4

7.1

7.2

Reset Time Scale
Select Previous/Next Event

Select Previous/Next Process

Zoom In/Out
Filter Dialog

Filter Processes

Hide Arrows

Follow CPU Forward

Follow CPU Backward
Synchronization

Time synchronization

Event synchronization

Window range synchronization

Selection range synchronization

Multiple Trace Synchronization

Preparation

Click Reset Time Scale button
Click Previous/Next Event button

Click Previous/Next Process button

Click Zoom In/Out button
Open Filter Dialog

1) Open Filter Dialog
2) Deselect several processes
3) Press Ok

Click Hide Arrows button

With focus on time graph, click Follow CPU
Forward button

With focus on time graph, click Follow CPU
Backward button

Select a random time in another view

Select a state-impacting event
(sched_switch, syscall, ...) in events table or
in Resources view using Select
Previous/Next event.

Select a new window range in Resources
view or in Histogram view.

In any other view that supports selection
range synchronization, select a new range.

1) Download traces.zip (if necessary) and
unzip into a local directory ${local}

2) Import kernel trace
${local}/traces/import/kernel-overlap-
testing

3) Import UST
${local}/traces/import/trace ust-overlap-
testing

4) Create experiment with trace of 2) in it

Open multiple traces that don't overlap in

Open multiple traces (no overlap) time

Change selected time and range

(no overlap)

Select a time and new range

LTTng 2.0 - ControlFlowView

Time range is reset to full range, states are
updated and new time range is propagated to
other views.

Previous or next state is selected. Selected
time is updated in other views.

Selected process is changed in table and
time graph. Vertical scroll bar updated.

Time range is zoomed in and out, relative to
center of selection or window. States are
updated and new time range is propagated to
other views.

Verify that all buttons are working correctly

Verify that only selected processes are
displayed in the view

Verify that arrows are not drawn in the time
graph

Time graph is updated to show the next state
for this cpu following the arrow, the event is
selected in the Events editor.

Time graph is updated to show the previous
state for this cpu following the arrow, the
event is selected in the Events editor.

Selected time line is updated. If selected time
is outside current range, time range is
updated to include it.

In addition to updating the selected time, the
process containing the state change is
selected and revealed. Vertical scroll bar is
updated if necessary.

Window range is updated.

Selection is highlighted. If begin time (T1) of
selected time range is outside the current
range, then window range is updated to
include it

View shows the last opened trace

Selected time line and time range is updated
to selected time and new range.
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Manual

SWTBot

Manual

Manual
Manual

Manual

Manual

SWTBot

SWTBot

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Pro tip: "Uncheck selected" and "Uncheck subtree" do the same thing

see bug 476148. Fixed in this release

Window range only updated for single time selection



73
7.4

7.5

7.6
7.7

8.1

8.2

8.3

Select other trace (no overlap)
Open multiple traces (overlap)

Change selected time and range
(overlap)

Select other trace (overlap)
Close all traces
Miscellaneous

Restart (Bug 409345)

Select single time (Bug 477009)

Window range synchronization
(Bug 477012)

Select different trace by clicking its Events
editor tab

Open multiple traces that overlap in time

Select a time and new range

Select different trace by clicking its Events
editor tab

Close all Events editor tabs

1) Open LTTng Kernel Trace
2) Select Control Flow View
3) Restart Eclipse

LTTng 2.0 - ControlFlowView

View is updated to show selected trace.
Selected time line and time range are
restored to the selected trace's previously
selected time and range.

View shows the last opened trace

Selected time line and time range is updated
to selected time and new range.

View is updated to show selected trace.
Selected time line and time range are set to
the newly selected time and range.

View is cleared.

Verify that Control Flow View is populated

1) Open LTTng UST trace while CFV is open Verify that current window range stays
2) Select event in events table doesn't change

1) Open Control Flow view, Resources view

and a kernel trace. Initial window range is

range 1'.

2) Go "right one page" on Control Flow view

by pressing right arrow in scroll bar.

3) Go "left one page" on Resources view by

pressing left arrow in scroll bar.

Verify that after each step the initial window

4) Go "right one page" on Control Flow view. range doesn't change
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Manual
Manual

Manual

Manual
Manual

Manual

Manual

Manual

See bug 477009. Fixed in this release

See bug 477012. Fixed in this release



LTTng 2.0 - ResourcesView

Section To Do Comment

LTTng 2.0 - Resources View

Target: Windows 7

Step Test Case Action Verification Comment
0 Prerequisites
Import LTTng Kernel traces in Tracing
0.1 Import traces project
Create an experiment with LTTng Kernel
0.2 Create experiment traces
1 View management

Open and reset LTTng Kernel Perspective,
1.1 Open perspective and select Resources view Resource view opens. SWTBot Pass

Resources Flow view is populated with
processes, sorted by Trace then TID. Child
processes appear under their parent, sorted
1.2 Open trace Open LTTng Kernel trace in Project Explorer by birth time. Range is set to initial offset. SWTBot Pass

Resource view is populated with traces
(sorted by name) and their resources as tree
Open experiment with LTTng Kernel traces children (sorted by resource type then

1.2 Open experiment in Project Explorer numerically) Range is set to initial offset. Manual Pass

1.3 Close view Close the Resources view View is closed. Manual Pass
Resources view is opened and populated

1.4 Open view Open the Resources view with processes. SWTBot Pass

2 View selection

Resource is highlighted. Selected time line is
Select a resource in the time graph (empty  updated. Other views are synchronized to
2.2 Select resource in time graph region) selected time. Manual Pass

State is highlighted in time graph. Selected
time line is updated. Other views are
23 Select state in time graph Select a state in the time graph synchronized to selected time. Manual Pass

3 Mouse handling

Time range is dragged. When mouse button
Ctrl-Drag move time graph left and right with is released, states are updated and new time
3.1 Drag move time range middle button range is propagated to other views. Pass

Time range is zoomed in and out, relative to
mouse cursor. When mouse wheel is stopped
) Zoom with mouse wheel up and down on for a short time, states are updated and new Zoom in and out with Ctir + Mouse wheel. Consider adding
3.2 Zoom time range (mouse wheel) header or ctrl mousewheel in the time graph time range is propagated to other views. Manual Pass that detail to the action description to clariry

Time range is zoomed in and out. When
mouse button is released, states are updated
Drag in time graph scale left and right with  and new time range is propagated to other

3.3 Zoom time range (mouse drag) left button views. Manual Pass
Time graph scrolls up and down. Selected
Scroll with mouse wheel up and down, process does not change. Vertical scroll bar
3.4 Mouse vertical scroll cursor outside time graph (in name space) updated. Manual Pass
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LTTng 2.0 - ResourcesView

Time graph scroll up and down and remain
3.5 Vertical scroll bar Click and drag vertical scroll bar aligned. Selected process does not change. Manual

Selection highlighted. When mouse button is
released, time range is zoomed to selection,
states are updated and new time range is
3.6 Drag select time range Drag select time graph with right button propagated to other views. Manual

Time range is reset to full range, states are
updated and new time range is propagated to

3.7 Double-click reset time range Double-click left button on time scale other views. Manual
Hover mouse in time graph over empty
3.8 Mouse hover (empty region) region Tool tip shows resource name only. Manual

Tool tip shows resource name, state name,
date, start time, end time, duration. For IRQ
state, IRQ number is shown. For
IRQ_ACTIVE/SOFT_IRQ_ACTIVE state,
3.9 Mouse hover (state) Hover mouse in time graph over state CPU is shown. Manual

Selection highlighted. Status bar of Eclipse is
updated with time information: T, T1, T2 and
delta, where T is the time of the mouse
position, T1 the first selected time, T2 the
second (draggged) selected time and delta
the time difference between T2-T1 (can be
3.10  Drag mouse seleection Drag select time graph with left button negative) Manual

On usermode and syscall tool tip shows also shows hover
time, tid and process name.

When not zoomed enough, tool tip does not show CPU for
IRQ_ACTIVE/SOFT_IRQ_ACTIVE state.

Selection highlighted. Status bar of Eclipse is
updated with time information: T, T1, T2 and
delta, where T is the time of the mouse

Click select with left button (begin time), position, T1 the left most selected time, T2
press shift key and click select another time the right most selected time and delta the
3.11  Shit key selection (end time) time difference between T2-T1 Manual

4 Keyboard handling
Keyboard navigation in time graph With focus on time graph, use UP, DOWN,  Selected process is changed. Vertical scroll

4.1 (process selection) HOME, END keys bar updated. Manual
Keyboard navigation in time graph With focus on time graph, use LEFT, RIGHT Previous or next state is selected. Selected
4.2 (state selection) keys time is updated in other views. Manual

5 Tool bar handling
The legend dialog is opened and can be

5.1 Show Legend Click Show Legend button closed. Manual
Time range is reset to full range, states are
updated and new time range is propagated to

5.2 Reset Time Scale Click Reset Time Scale button other views. Manual
Previous or next state is selected. Selected

5.3 Select Previous/Next Event Click Previous/Next Event button time is updated in other views. Manual
Selected process is changed in time graph.

54 Select Previous/Next Process Click Previous/Next Process button Vertical scroll bar updated. Manual

Time range is zoomed in and out, relative to
center of selection or window. States are
updated and new time range is propagated to
55 Zoom In/Out Click Zoom In/Out button other views. Manual

6 Synchronization

Selected time line is updated. If selected time
is outside current range, time range is

X . . . . h A FIXED failed when time outside current range:
6.1 Time synchronization Select a random time in another view updated to include it. Manual

https://bugs.eclipse.org/bugs/show_bug.cgi?id=476148
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6.2

6.3

7.1

7.2

7.3
7.4

7.5

7.6
7.7

8.1

Time range synchronization
Time range selection
synchronisation

Multiple Trace Synchronization

Preparation

Open multiple traces (no overlap)

Change selected time and range
(no overlap)

Select other trace (no overlap)
Open multiple traces (overlap)

Change selected time and range
(overlap)

Select other trace (overlap)
Close all traces

Miscellaneous

Restart (Bug 409345)

LTTng 2.0 - ResourcesView

Select a new time range in Resources view
or in Histogram view.

In any other view that supports range
synchronization, select a new range.

1) Download traces.zip (if necessary) and
unzip into a local directory ${local}

2) Import kernel trace
${local}/traces/import/kernel-overlap-
testing

3) Import UST

${local}/traces/import/trace ust-overlap-

testing

4) Create experiment with trace of 2) in it

Open multiple traces that don't overlap in
time

Select a time and new range

Select different trace by clicking its Events
editor tab

Open multiple traces that overlap in time

Select a time and new range

Select different trace by clicking its Events
editor tab

Close all Events editor tabs

1) Open LTTng Kernel Trace
2) Select Resource View
3) Restart Eclipse

Time range is updated.

Selection is highlighted. If begin time (T1) of
selected time range is outside the current
range, then time range is updated to include it

View shows the last opened trace
Selected time line and time range is updated
to selected time and new range.

View is updated to show selected trace.
Selected time line and time range are
restored to the selected trace's previously
selected time and range.

View shows the last opened trace

Selected time line and time range is updated
to selected time and new range.

View is updated to show selected trace.
Selected time line and time range are set to
the newly selected time and range.

View is cleared.

Verify that Resources View is populated
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Manual

Manual

Manual

Manual
Manual

Manual
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Section
LTTng 2.0 - Control View

Target: Ubuntu 14.04 64 bit

Step

0

0.1

w

A1

w

2

3.4

3.5

3.6

LTTng Tools 2.6.0, Built-in SSH
Test Case

Prerequisites

Set Proxy
General
Open perspective

Manage View
Close view

Open Control view

Connection Handling

Create Host Connection

Disconnect

Connect

Select Host Connection

Node contexts sensitive menu (host
connected)

View button enable state (host
connected)

Pass
103

Action

For the tests below a Ubuntu machine with LTTng 2.0 installed
(with Ittng tools 2.0.x) is required. Either create a machine
yourself or use machine vCloud machine 142.133.166.54.
Make sure that the root session daemon is running (sudo Ittng
list -k) and have one UST process running (e.g. from Ittng-tools
git repository under tests/hello.cxx)

a) Window — Preferences — General — Network Connections
b) Set “Active Provider” to “Direct”

Open and reset LTTng Kernel Perspective

Close Control View

Use menu Window — Show View — Other ... — Lttng —
Control

1) Click Button 'New Connection...!

2) Select Tree item "Built-in SSH" and click on Create

3) Enter Connection Name (e.g. MyHost), enter Host Name (a
DNS name or IP address), username and password

4) Click 'Finish'

5) In Tree select the newly create connection and click on 'Ok’
a) Select host to disconnect and click Button 'Disconnect’

b) Redo test with context sensitive menu item 'Disconnect’

a) Select host to connect and click Button 'Connect’
b) Redo test with context sensitive menu item '‘Connect'

) Restart Eclipse

) Click Button 'New Connection...'

) Select the host previously created

) Select 'OK'. (Afterwards enter user ID and Password if
necessary)

1
2
3
4

1) Connect to remote host
2) select connected node and click right mouse button

1) Connect to remote host (if necessary)
2) select connected node

LTTng 2.0 - Control

Fail Type

Verification Type

LTTng Tracer Control User Guide:
hitp:77wiki-eclipse.org/Linux_Tools_Project/LTTng2/User
—Guide#L T Ing_Tracer_control

LTTng Kernel perspective opens with correct Control

view on the left bottom corner SWTBot

Control view is removed from perspective Manual

Verify that Control view is shown Manual

Make sure that after 4) the new connection is shown in
the tree. Verify that the new host is shown in the Control
view (with 'Connection Name'. After Ssh connection has
been established, make sure that Provider and Session
nodes are created in the Control view underneath the
host. Verify that all active Providers (Kernel and UST

providers) are shown under the 'Provider' node. Manual

Verify that icon for the corresponding node changes to
the disconnect icon and all sub-nodes are removed. Manual
Verify that icon for the corresponding node changes to

the connected icon and after successful SSH connection

all data is retrieved form the remote host (Providers,

sessions etc). Manual

Make sure that SSH connection is established and all
data is retrieved from the remote host ( (Providers,

sessions etc). Manual

Verify that menu items are shown and enabled/disabled
depending on state:

'Connect' (disabled)

Disconnect (enabled)

Refresh (enabled)

Delete (disabled) Manual

Verify enable state of view buttons:
'New Connection..."' (enabled)
'Connect' (disabled)

‘Disconnect' (enabled)

'Refresh' (enabled)

'Delete’ (disabled)

'Start' (disabled)

'Stop' (disabled)

'Destroy Session..." (disabled)
'Record Snapshot' (disabled)

'Import..." (disabled) Manual
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To Do

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Comment
18

Comment


LTTng_Tracer_Control
LTTng_Tracer_Control
LTTng_Tracer_Control

3.7

3.8

3.9

3.10

4.1

4.2

4.3

4.4

4.5

46

4.7

Node contexts sensitive menu (host
disconnected)

View button enable state (host
connected)

Delete

Create Host Connection with ssh port

Session Handling
Preparation

Sessions Context Sensitive Menu

Create Session (default location)

Create Session (custom location)

Create Session — session already exists
n

Create Session — session already exists
on node

Session Context Sensitive menu
(session inactive)

1) Disconnect from node
2) select disconnnected node and click right mouse button

1) Disconnect to remote host (if necessary)
2) select disconnected node if necessary

a) Select node to delete (state disconnected) and click on
button 'Delete’
b) Redo test with context sensitive menu item 'Delete’

re-do 3.1 but this time specify a port number other than default
SSH port 22

1) Connect to remote host

Select 'Sessions' in tree and click right mouse button

Click right mouse button on 'Sessions'
Select ‘Create Session..." in the context sensitive menu

n
2)
2; Enter session name 'MySession', keep 'Session Path' empty

Select 'Ok’

1) Click right mouse button on 'Sessions'

2) Select ‘Create Session..." in the context sensitive menu
3) Enter session name 'MyOtherSession'

4) enter custom path (/tmp/myTraces) for 'Session Path’
5) Select 'Ok’

1) Click right mouse button on 'Sessions'
2) Select ‘Create Session..." in the context sensitive menu

) Enter session name 'MySession', keep 'Session Path' empty session 'MySession' already exists in the tree.

1) login to the remote host using a command shell
2) type Ittng create newSession and press enter. This will
create a session which is not know by the Control view.
3) Click right mouse button on 'Sessions'

Select ‘Create Session..." in the context sensitive menu

4)
g; Enter session name 'MySession', keep 'Session Path' empty exists on the node. Select 'Details": Verify that the

Select 'Ok’

Select newly created session and click right mouse button

LTTng 2.0 - Control

Verify that menu items are shown and enabled/disabled
depending on state:

'Connect' (enabled)

'Disconnect' (disabled)

'Refresh’ (disabled)

‘Delete’ (enabled) Manual

Verify enable state of view buttons:
'New Connection...' (enabled)
‘Connect' (enabled)

'Disconnect' (disabled)

'Refresh’ (disabled)

'Delete’ (enabled)

‘Start' (disabled)

'Stop' (disabled)

'Destroy Session..." (disabled)
'Record Snapshot' (disabled)

'Import..." (disabled) Manual

Verify that host is removed from the control view. Manual

The connection should fail (unless remote is configured

for the specified port) Manual

Verify that menu items are shown and enabled:
'Refresh’, 'Create Session...", 'Execute Command Script )
L Manual

Verify that new session is added under the Session tree
node. Verify properties in Properties view (by selecting
the session in the Control view):

'Session name' (=MySession)

'Session Path’' (=lhome/<user>/traces/MySession_<date

and time>) and 'State' (<INACTIVE) Manual

Verify that new session is added under the Session tree
node. Verify properties in Properties view (by selecting
the session in the Control view):

'Session name' (=MyOtherSession)

'Session Path' (=/tmp/myTraces) and 'State’
(=INACTIVE)

Manual

Make sure that an error message appears in the
message area of the dialog box with information that |
i ists i Manual

Verify that an error dialog box will show with information
that command to create a session failed. session already

command error detail is shown (with return value (28)) Manual

Verify context sensitive menu items:
'Refresh’ (enabled)

'Start' (enabled)

'Stop' (disabled)

'Destroy Session...' (enabled)

'Import..." (enabled

'Enable Channel...' (enabled)

'Enable Event (default channel)..." (enabled)

'Record Snapshot' (disabled) Manual
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4.8

4.9

4.10

411

4.12

5.1

5.2

53

54

55

5.6

View button enable state (session
inactive)

Start Session

Session Context Sensitive menu
(session active)

View button enable state (session
active)

Destroy Session

Kernel Channel Handling

Preparation

Enable Channel on session level
(default values)

Enable Channel on domain level (default

values)

Enable Channel — channel already
exists

Domain Context Sensitive menu

Channel Context Sensitive menu

Select newly created session (enable an event before)
Eable an event

a)
b) Select session and click on button 'Start'
c) Redo test with context sensitive menu item 'Start'

Select started session and click right mouse button

Select started session

In the Control view select session 'MyOtherSession'
Click right mouse button

n
2)
3; select 'Destroy Session..." in the context sensitive menu
4

Select 'Ok’ in the confirmation dialog box

1) Connect to remote host
2) Create new Session 'MyOtherSession’

1) Select session and right mouse click
g) Select menu item 'Enable Channel...'
values

4) Select Kernel

5) Click on 'Ok’

1) Select domain 'Kernel' and right mouse click
2) Select menu item 'Enable Channel...'

3) Enter Channel name (e.g. MyOtherChannel)
4) Change values

5) Click on 'Ok’

1) Select domain 'Kernel' and right mouse click
2) Select menu item 'Enable Channel'

3) Enter Channel name (e.g. MyOtherChannel) and keep

default values
4) Click on 'Ok’

Select domain 'Kernel' and click right mouse button

Select channel 'MyChannel' and click right mouse button

) Enter Channel name (e.g. myChannel) and keep default

LTTng 2.0 - Control

Verify enable state of view buttons:
‘New Connection...' (enabled)
‘Connect' (disabled)
'Disconnect' (disabled)
'Refresh’ (enabled)

'Delete’ (disabled)

'Start' (enabled)

'Stop' (disabled

'Destroy Session..." (enabled)
‘Import..." (enabled)

'Record Snapshot' (disabled)

Verify that Session icon changes to 'ACTIVE' icon. Verify
that property view shows 'ACTIVE' for the session state

Verify context sensitive menu items:
'Refresh’ (enabled)

'Start’ (disabled)

'Stop' (enabled)

'Destroy Session..." (disabled)

‘Import...' (disabled)

'Enable Channel..." (disabled)

'Enable Event (default channel)...' (disabled)

Verify enable state of view buttons:
'New Connection...' (enabled)
'Connect' (disabled)

'Disconnect' (disabled)

'Refresh’ (enabled)

'Delete’ (disabled)

‘Start' (disabled)

'Stop' (enabled)

'Destroy Session..." (disabled)
'Import..." (disabled)

Verify that session is removed from the control view.

Verify that domain 'Kernel' is created under session and

channel is added under the domain. Verify that default
values for the channel are displayed in the Properties
view after selecting the channel in the tree.

Verify that channel is added under the domain. Verify
that correct values for the channel are displayed in the
Properties view after selecting the channel in the tree.

Verify that error dialog box is opened notifying that
channel already exists.

Verify context sensitive menu items:
'Refresh’ (enabled)

'Enable Channel..." (enabled

'Enable Event (default channel)...' (enabled)
'Add Context...” (enabled)

'Calibrate” (enabled)

Verify context sensitive menu items:
'Refresh’ (enabled)

'Enable Channel' (disabled)

'Disable Channel' (enabled)

'Enable Event (default channel)...' (enabled)
'Add Context...” (enabled)
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5.7

58

6.1
6.2

71

72

73

74

7.5

76

77

8.1

Disable Channel

Enable Channel

UST Channel Handling

Enable Channel on session level
(default values)

Enable/Disable Channel

Kernel Event Handling

Enable Event on session level (all
tracepoints)

Enable Event on domain level (syscalls)

Enable Event on Channel level
(Dynamic Probe)

Enable Event on Channel level

(Dynamic Function Probe)

Disable Event

Enable Event

Enable Tracepoint Event using filter in
tree (Bug 450526)

UST Event Handling

Enable Event on session level (all
tracepoints)

1) Select channel 'MyChannel' and click right mouse button
2) Select 'Disable’ menu item

1) Select channel 'MyChannel' and click right mouse button 2)
Select 'Enable’ menu item

1) Select session and right mouse click
2) Select menu item 'Enable Channel..."
3) Enter Channel name 'MyChannel'
4) Select UST

5) Click on Button 'Default’

5) Click on 'Ok’

Redo tests 5.7 and 5.8 with UST channel

) Select session and click right mouse button

) Select menu item 'Enable Events (default channel)...!
) Select 'Kernel'

) Select Radio button for 'Tracepoint Events'

) Select top level tree node 'All'

) Click on Ok

1) Select domain Kernel and click right mouse button
2) Select menu item 'Enable Events (default channel)...!
3) Select 'Kernel'

4) Select Radio button for 'All Syscalls'

5) Click on Ok

Select a channel (e.g. channel0) and click right mouse
tton

Select menu item 'Enable Events...'

Select Radio button for 'Dynamic Probe’

Enter Event Name 'MyEvent' and Probe (e.g. 0xc0101280,
see file /boot/System.map<kernel version>)

5) Click on Ok

1
by

)
u
2)
3)
4)

1) Select a channel (e.g. channel0) and click right mouse

button

2) Select menu item 'Enable Events...'

3) Sbelect Radio button for '‘Dynamic Function Entry/Return
robe'

4) Enter Event Name 'MyOtherEvent' and Probe (e.g.

create_dev, see file /proc/kallsyms or

/boot/System.map<kernel version>)

5) Click on Ok

1) Select multiple events under a channel (not syscalls) and
click right mouse button
2) Select 'Disable’ menu item

1) Select multiple disabled events and click right mouse button
2) Select 'Enable’ menu item

1) Create Session

2) Select session, right-mouse click and select 'Enable Events
(default channel)'

3) Enter a filter (e.g. sched) for the tracepoint tree and then
select All

4) Click on Ok

1) Select session and click right mouse button

2) Select menu item 'Enable Events (default channel)...'
3) Select 'UST'

4) Select Radio button for 'Tracepoint Events'

5) Select top level tree node 'All'

6) Click on Ok

LTTng 2.0 - Control

Verify that channel is disabled (disabled channel icon
shown, state DISABLED shown in Properties view, menu
item 'Disable’ is disabled and menu item 'Enable’ is
enabled

Verify that channel is enabled (enabled channel icon
shown, state ENABLED shown in Properties view, menu
item 'Disable’ is enabled and menu item 'Enable’ is
disabled

Verify that domain 'UST global' is created under session
and channel is added under the domain. Verify that
default values for the channel are displayed in the
Properties view after selecting the channel in the tree.

See 5.7/5.8

Verify that default channel (channelQ) is create under
domain 'Kernel' and that all tracepoint events are added
under the channel with state ENABLED. Verify
properties view show correct values when selecting a
event in the tree (Event Type=TRACEPOINT,
State=ENABLED)

Verify that event with name syscalls is added under the
default channel (channel0) with state ENABLED. Verify
properties view show correct values when selecting a
event in the tree (Event Type=SYSCALL,
State=ENABLED)

Verify that event with name 'MyEvent' is added under the
respective channel with state ENABLED. Verify
properties view show correct values when selecting a
event in the tree (Event Type=Probe, State=ENABLED,
Address=0xc0101280, Event Name=MyEvent)

Verify that event with name ‘MyOtherEvent' is added
under the respective channel with state ENABLED.
Verify properties view show correct values when
selecting a event in the tree (Event Type=Function,
State=ENABLED, Symbol=create_dev, Offset=0x0,
Event Name=MyOtherEvent)

Verify that all selected events are disabled (disabled
event icon is shown, state DISABLED is shown in
Properties view, menu item 'Disable’ is disabled and
menu item ‘Enable’ is enabled

Verify that selected events are enabled (enabled event
icon is shown, state ENABLED is shown in Properties
view, menu item 'Disable' is enabled and menu item
'Enable’ is disabled

Verify that only the selected trace points (filtered) are
enabled and not all UST trace poionts

Verify that default channel (channelQ) is create under
domain 'UST global' and that a wildcard event “*” is
create under the channel with state ENABLED. Verify
properties view show correct values when selecting a
event in the tree (Event Type=TRACEPOINT,
State=ENABLED)
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Since LTTng Tools 2.2 the event type displayed in the
list command is function instead of probe.

address not allowed Command to change state o
Command failed! Command: Ittng --mi xml enabl

Error Ouptut:

Error: Event myEvent: Non-default channel exists
Return Value: 83

<?xml version="1.0" encoding="UTF-8"?>

command: p

Command to change state of events failed
Command failed! Command: Ittng --mi xml enabl
Error Ouptut:

Error: Event bob: Non-default channel exists withi
Return Value: 83

<?xml version="1.0" encoding="UTF-8"?>

command: p




8.2

83

8.4
8.5

8.6

9.1

9.2

9.3

1) Select domain 'UST global' and click right mouse button
2) Select menu item 'Enable Events (default channel)...'

3; Select Radio button for ‘Wildcard'
4
5)

Enable Event on domain level

1) Select a channel (create if necessary) and click right mouse

2) Select menu item 'Enable Events...'

3) Select Radio button for 'Log Level'
Enter Event Name 'MyEvent'
Select log level TRACE_ERR

(wildcards) Click on Ok
button
4)
5)
Enable Event on Channel level (log 6) Select radio button for loglevel
level) 7) Click on Ok

1) Select a channel (create if necessary) and click right mouse

button

2) Select menu item 'Enable Events...'
3) Select Radio button for 'Log Level'
4) Enter Event Name 'MyOtherEvent'

5) Select log level TRACE_INFO
6) Select radio button for loglevel-olny

Enable Event on Channel level (log level
oly) 7) Click on Ok

Enable/Disable Event

tree (Bug 450526) 4) Click on Ok

Contexts Handling

S

1
2
3
p
4

Add Context (to channel) Click on 'Ok’

1) Select UST channel and click right mouse button
2) Select menu item 'Add Contexts..."
3) Expand tree and select contexts procname, pthread_id, vpid

and vtid
Add Context (to channel) 4) Click on 'Ok’

1) Select 1 Kernel tracepoint event and click right mouse

button

2) Select menu item 'Add Contexts..."
3) Expand tree and select some contexts (e.g prio, procname,

pid)
4) Click on 'Ok’

Note: only when using LTTng Tools 2.0.x - 2.1.x. For v2.2 or
later this menu item has to be disabled

Add Context (to event)

Enable Events (from Provider)

Enter a wildcard (e.g. ust*)

Redo tests 7.5 and 7.6 with UST events

1) Create Session

2) Select session, right-mouse click and select 'Enable Events
(default channel)'
Enable Tracepoint Event using filter in  3) Enter filter for the tracepoint tree and then select All

) Select kernel channel and click right mouse button
) Select menu item 'Add Contexts..."
) Expand tree and select some contexts (e.g prio, procname,

LTTng 2.0 - Control

Verify that event with wildcarded name (e.g ust*) is
added under the default channel (channelO) with state
ENABLED. Verify properties view show correct values
when selecting a event in the tree (Event
Type=TRACEPOINT, State=ENABLED)

Verify that event with name 'MyEvent' is added under the
respective channel with state ENABLED. Verify
properties view show correct values when selecting a
event in the tree (Event Type=TRACEPOINT,
State=ENABLED, Log Level=<=TRACE_ERR, Event
Name=MyEvent)

Verify that event with name 'MyOtherEvent' is added
under the respective channel with state ENABLED.
Verify properties view show correct values when
selecting a event in the tree (Event Type=TRACEPOINT,
State=ENABLED, Log Level= ==TRACE_INFO, Event
Name=MyOtherEvent).

See 7.5/7.6

Verify that only the selected trace points (filtered) are
enabled and not all UST trace poionts

Verify that command is successful (no error).
NOTE: There is no way to retrieve added contexts from
the trace. Therefore GUI cannot display this information.

Verify that command is successful (no error).

NOTE 1: There is no way to retrieve added contexts
from the trace. Therefore GUI cannot display this
information.

NOTEZ2: For UST only contexts procname, pthread_id,
vpid and vtid are supported

Verify that command is successful (no error).
NOTE: There is no way to retrieve added contexts from
the trace. Therefore GUI cannot display this information.
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Manual
Note: In LTTng backend v2.4 and later provide
information if a loglevel is for a range (e.g. <=
TRACE_ERR) This will be displayed by the properties
Manual view now
Note: In LTTng backend v2.4 and later provide
information if a loglevel is for a single level (e.g. ==
TRACE_INFO) This will be displayed by the properties
Manual view now
Manual
Manual
duplicated event, and gives a failure.
Command to change state of events
failed
Command failed! Command: Ittng --mi
xml enable-event log -u -s
MyOtherSession -c¢ Grimace --tracepoint
Error Ouptut:
Error: Event log: UST event already
enabled (channel Grimace, session
MyOtherSession)
Return Value: 55
<?xml version="1.0" encoding="UTF-
8"7>
<command><name>enable-
event</name><output><events><event>
<name>log</name><type>TRACEPOIN
T</type><enabled>false</enabled><filter
>false</filter><exclusion>false</exclusio
n><success>false</success></event></
events></output><success>false</succe
Manual ss></command>
Manual
Per event adding of context is not supported by LTTng
Manual N/A  Tools anymore (starting from LTTng 2.2)



10.1

10.2

1

111

11.2

1.3

114

131

Enable Kernel Events

Enable UST Events

Importing to Project

Preparation

Import to project

Import to project (Overwrite)

Import to project (Rename)

Import to project (Overwrite
Confirmation)

Refresh

Refresh

Calibration

Preparation

1) Create a new session

2) Select multiple Kernel Tracepoint events under Providers —

Kernel

3) click right mouse button

4) select menu item 'Enable Event...'
5) Select newly created session

6) Select 'Ok’

1) Make sure that UST application is running on remote host

(see step 0)
2) Create a new session
3) Create a channel under domain 'UST global'

4) Select multiple UST Tracepoint events under Providers ->

<UST Process>

5) click right mouse button

6) select menu item 'Enable Event..."
7) Select newly created session

8) Select newly created channel

9) Select 'Ok’

1) Create new session

2) Enable all Kernel Tracepoint events
3) Enable all Kernel sycalls

4) Enable all UST events

5) Start Tracing

6) Stop Tracing after a few seconds
7) Create new Tracing Project

1) Select session from 11.1 and click right mouse button
2) Select 'Import..."

3) Select Ok

1) Repeat step 1 — 3 of test case 11.2

2) In dialog box select '‘Overwrite existing traces without
warning'

3) Select Ok

1) Repeat step 1 — 3 of test case 11.2

2)Select Ok

3) For each trace a confirmation dialog will open:
Select 'Rename’ and change trace name

4) Select 'Ok’

1) Repeat step 1 — 3 of test case 11.2

2)Select Ok

3) For each trace a confirmation dialog will open:
Select 'Overwrite'

4) Select 'Ok’

Press refresh button and context sensitive menu item for
different selections

1) Create new session

2) Enable all Kernel Tracepoint events
3) Enable all Kernel sycalls

4) Enable all UST events

LTTng 2.0 - Control

Verify that domain 'Kernel' is created under the new
session. Verify that default channel ‘channel0' is created
under the domain. Verify that selected events are added
under the channel and are ENABLED.

Verify that selected events are added under the selected

channel and are ENABLED.

After 2 verify that all traces are selected by default and
also that the tracing project with name 'Remote’ is
selected.

Verify that during import a progress dialog is opened to
show the progress of the import operation.

Verify that traces are imported to the project wiith name
Remote and its Traces folder. Verify that for the kernel
trace the trace type "LTTng Kernel Trace" is set and for
the UST traces the trace type "LTTng UST Trace" is set.
Create Experiment, select all traces and open

Experiment. Make sure that all view are populated
correctly in the LTTng Kernel Perspective.

Verify that traces are imported and existing traces are
overwritten

Verify that traces are imported with a different name

Verify that traces are imported and existing traces are
overwritten

Verify that the Control View is refreshed.
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Start Tracing
Select Domain 'Kernel' and click right mouse button

Redo step 2-3 with domain 'UST global'

LTTng 2.0 - Control

Verify that Calibrate command is executed without error.
e test case 1S To Doed if no Error occurred.
‘See also calibrate section in link below for a Use Case of

n

2)

3) Select menu item Calibrate
4; That feature. http://lting.org/files/doc/man-

5 ] 7T Rl

13.1 Calibrate Stop tracing pages/man1/lting. T.htm Manual
14 Event Filtering (LTTng 2.1)
For the tests below a Ubuntu machine with LTTng 2.1 installed
(with Ittng tools 2.1.x) is required. Either create a VM machine
yourself (e.g. on Virtualbox) or install it locally on your native
Ubuntu (if correct version). Make sure that the root session
daemon is running (sudo lttng list -k) and have one UST
process running (e.g. from Ittng-tools git repository under
14.1 tests/hello.cxx)
1) Connect to remote host
14.2  Preparation 2) Create new Session 'FilterSession'
1) Select session and click right mouse button Verify that default channel (channelQ) is create under
2) Select menu item 'Enable Events (default channel)...' domain 'UST global' and that the corresponding event is
3) Select 'l created under the channel with state ENABLED.
4) Select Radlo button for 'Tracepoint Events'
5) Select one tracepoint Verify that Properties view shows correct values for this
6) Enter filter expression on a event field event (Event Type=TRACEPOINT, State=ENABLED,
14.3  Enable UST Event on session level 7) Click on 'Ok’ Filter=with filter) Manual
1) Execute 14.3
2) Select one UST Tracepoint event under Providers -> <UST
Process> Verify that selected event is added under the selected
3) click right mouse button channel.
4) select menu item 'Enable Event..."
5) Select newly create session and channel Verify that Properties view shows correct values for this
6) Enter filter expression on a event field event (Event Type=TRACEPOINT, State=ENABLED,
14.4 Enable UST Event from provider 7) Click on 'Ok’ Filter=with filter) Manual
1) Start Tracing
2) Stop Tracing after a view seconds
3) Import Trace to Project
4) Open Trace Make sure that only events are shown in the events
145  Create trace 5) Destroy Session table that met the condition in the filter expressions Manual
Create Session With Advanced
15 Options LTTng v2.1)
For the tests below a Ubuntu machine with LTTng 2.1 installed
(with Ittng tools 2.1.x) is required. Either create a VM machine
yourself (e.g. on Virtualbox) or install it locally on your native
Ubuntu (if correct version). Make sure that the root session
daemon is running (sudo lttng list -k) and have one UST
process running (e.g. from Ittng-tools git repository under
15.1 tests/hello.cxx)
After 2) verify that advanced options are shown (e.g.
Trace Path, Protocol, Address and Port)
1) Open Create Session Dialog box After 3) verify that advanced option are not shown and
Create Session Dialog - Advanced 2) Select "Advanced >>>" only basic options are there (Session Name and Session
15.2  Button 3) Select "<<< Basic" Path) Manual
After 2) verify that data Protocol and data Address is
1) Open Create Session Dialog box and select "Advanced enabled. Note that the ports cannot be configured for net
>>>" and net6 when this button is unchecked. -> port text
2) Uncheck checkbox"Use same protocol and address for data fields are disabled
Create Session Dialog - Check box "Use and control"
same protocol and address for data and 3) Check checkbox "Use same protocol and address for data  After 3) Verify that data Protocol and data Address are
153  control" and control" disabled Manual
1) Open Create Session Dialog box and select "Advanced
>>>" Verify that the data protocol dropdown menu shows net,
15.4  Create Session Dialog - Protocol list net6 and file Manual
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http://lttng.org/files/doc/man-pages/man1/lttng.1.html
http://lttng.org/files/doc/man-pages/man1/lttng.1.html
http://lttng.org/files/doc/man-pages/man1/lttng.1.html
http://lttng.org/files/doc/man-pages/man1/lttng.1.html

15.5

15.6

15.7

15.8

15.9

15.10

15.11

Create Session Dialog - Protocol list 2

Create Session Dialog - Protocol
propagation

Create Session Dialog - Address
propagation

Create Session Dialog - Protocol
propagation 2

Create trace with file protocol

Create trace with file protocol and trace
path

Create trace with net protocol

LTTng 2.0 - Control

1) Open Create Session Dialog box and select "Advanced
>>>"
2) Uncheck checkbox "Use same protocol and address for After 2) verify that the data protocol dropdown menu

data and control" shows net, net6, tcp and tcp Manual
After 2) verify that net6 is propagated to the data
protocol and and that the data and control port text fields

1) Open Create Session Dialog box, select "Advanced >>>"  are enabled

2) Select net6 for Control Protocol After 3) verify that file is propagated to the data protocol

3) Select file for Control Protocol and that the data and control port text fields are disabled. Manual

1) Open Create Session Dialog box, select "Advanced >>>"  After 2) verify that the IP address is propagated to the

2) Enter IP address data address field Manual

1) Open Create Session Dialog box and select "Advanced

>>>"

2) Uncheck checkbox "Use same protocol and address for

data and control"

3) Select tcp for control protocol and tcp6 for data protocol

4) Check checkbox "Use same protocol and address for data  After 4) make sure that both data and control protocol

and control" show net Manual
Verify that the traces are stored on the remote host
under /tmp/testTraces/<session name + date>/kernel
and /tmp/testTraces/<session name +

1) Open Create Session Dialog box and select "Advanced date>/ust/<application(s)> repectively.

>>>"

2) Enter session name, select file protocol and enter directory  After 2) make sure that the Session Path in the Property

/tmpltestTraces/ in address field and press ok View shows the URL with the configured parameters

3) Enable events, start tracing, wait for a few seconds, stop

tracing Verify that the remote import dialog box opens at step 4

4) Import traces to a existing tracing project (as described in test cases 11.x) and it is possible to

5) Destroy session transfer the traces to the tracing project. Manual
Verify that the traces are stored on the remote host
under /tmp/testTraces/newPath/kernel and

1) Open Create Session Dialog box and select "Advanced /tmpl/testTraces/newPath/ust/<application(s)>

>>>" repectively.

2) Enter session name, select file protocol and enter directory

/tmp/tmpTraces/ in address field, enter /newPath in "Trace After 3) make sure that the Session Path in the Property

Path" text field and press ok View shows the URL with the configured parameters

3) Enable events, start tracing, wait for a few seconds, stop

tracing Verify that the remote import dialog box opens at step 4

4) Import traces to a existing tracing project (as described in test cases 11.x) and it is possible to

5) Destroy session transfer the traces to the tracing project. Manual
Verify that the traces are stored on the Eclipse local
machine under /home/<user name>/lttng-traces/<remote
machine name>/<session name + date>/kernel and
/home/<user name>/Ittng-traces/<remote machine
name>/<session name + date>/ust/<application(s)>

1)|St§|;l relayd on Eclipse local machine (default settings: Ittng- repectively.

relay

2) Open Create Session Dialog box and select "Advanced After 3) make sure that the Session Path in the Property

>>>" View shows the URL with the configured parameters

3) Enter session name, select net protocol and enter IP

address of Eclipse local machine in address field and press ok After 5) Verify that dialog box for selecting a tracing

4) Enable events, start tracing, wait for a few seconds, stop project is openend that after selecting a project and

tracing pressing next the default trace import wizard opens.

5) Import traces to a existing tracing project Then verify that it is possible to transfer the traces to the

6) Destroy session tracing project. Manual
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After import the root directory is newPath. However |
expected tmpTrace with sub-dir newPath. Needs to be
investigated



15.12

15.13

15.14

16.1
16.2
16.3

16.4

16.5

16.6

16.7

16.8

16.9

16.10

16.11

Create trace with tcp protocol and port

Live Streaming Session (UST) - Initial
implementation

1) Uncheck checkbox "Use same protocol and address for
data and control"

2 ) Start relayd on Eclipse local machine with specified ports

(Ittng-relayd -C tcp://0.0.0.0:1234 -D tcp://0.0.0.0:5678)
3) Open Create Session Dialog box and select "Advanced
>>>"

4) Enter session name, select tcp protocol and enter IP

address of Eclipse local machine in address field, specify data

and control ports and press ok

5) Enable events, start tracing, wait for a few seconds, stop
tracing

6) Import traces to a existing tracing project

7) Destroy session

1) Start relayd on Eclipse local machine (default settings: Ittng-

relayd)

2) Select Live Mode

3) Open Create Session Dialog box and select "Advanced
>>>"

4) Enter session name, select net protocol and enter IP
address of Eclipse local machine in address field, keep
defaults for Live Connection and Live Delay, and press ok

5) Enable UST events (per UID channel), start tracing, wait for

a few seconds, stop tracing
6) Import traces to a existing tracing project
7) Destroy session

1) Start relayd on Eclipse local machine (default settings: Ittng-

relayd

2) Select Live Mode

3) Open Create Session Dialog box and select "Advanced
>>>"

4) Enter session name, select net protocol and enter IP
address of Eclipse local machine in address field, keep
defaults for Live Connection and Live Delay, and press ok

5) Enable Kernel events, start tracing, wait for a few seconds,

stop tracing

Live Streaming Session (Kernel) - Inititial 6) Import traces to a existing tracing project

Implementation

Preferences

Open Preference Dialog
Enable Logging
Disable Logging

Test Logging level none

Test Verbose Logging (Level 1)

Test Verbose Logging (Level 2)

Test Verbose Logging (Level 3)

Append Mode

Change Tracing Group

Change execution timeout

Reset

7) Destroy session

Open Preferences (Menu -> Preferences -> Tracing -> LTTng

Tracer Control Preferences)
In Tracer Control Prferences, check checkbox Logging
In Tracer Control Prferences, uncheck checkbox Logging

Execute 16.2 and execute some commands (e.g. create
session, enable event)

1) Execute 16.2

2) select verbose level Level 1

3) Execute some commands (e.g. create session, enable
event)

1) Execute 16.2

2) select verbose level Level 2

3) Execute some commands (e.g. create session, enable
event)

1) Execute 16.2

2) select verbose level Level 3

3) Execute some commands (e.g. create session, enable
event)

Check checkbox Append, restart Eclipse and open Tracer
Control Preferences

Change Tracing group (e.g. tracing2) and execute a command

(while logging enabled)

Change Execution Timeout

Reset to defaults

LTTng 2.0 - Control

Verify that the traces are stored on the Eclipse local
machine under /home/<user name>/lttng-traces/<remote
machine name>/<session name + date>/kernel and
/home/<user name>/Ittng-traces/<remote machine
name>/<session name + date>/ust/<application(s)>
repectively.

After 4) make sure that the Session Path in the Property
View shows the URL with the configured parameters

After 6) Verify that dialog box for selecting a tracing
project is openend that after selecting a project and
pressing next the default trace import wizard opens.
Then verify that it is possible to transfer the traces to the
tracing project.

Verify that session is created successfully. Verify that
after 6) the trace appears in the Traces directory of
Remoter project. Verify that relevants views are updated
when new data arrives

Verify that session is created successfully. Verify that
after 6) the trace appears in the Traces directory of
Remoter project. Verify that relevants views are updated
when new data arrives

Verify that tracer control preferences exists and shows
Tracing Group, Logging, Log File (always disabled),
Append, Verbose Level (None, Level 1, Level2 Level 3)

Verbose Level radio buttons will be enabled
Verbose Level radio buttons will be disabled

Make sure that log file is created and contains the
executed commands and command replies

Make sure that log file contains the executed commands
with -v option (e.g. Ittng -v create session) and the
command replies come with debug information

Make sure that log file contains the executed commands
with -vv option (e.g. Ittng -vv create session) and the
command replies come with debug information

Make sure that log file contains the executed commands
with -vvv option (e.g. Ittng -vvv create session) and the
command replies come with debug information

Verify that tracer control preferences are persisted and
the log file is opened in append mode (old file is not
overwritten)

Verify that Ittng command is executed with command line
opti;)n -g <group>. Ignore any command reply errors (if
any)

After verify that values smaller than 5 and bigger than
600 are rejected

Verify: Group=tracing, Logging is deselected, Append is
deselected, Verbose Level=None), and Command
Timout is 15
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No way to specify destination in tracing project.
No check for name collision of the trace name
Not possible yet to trace per PID

XML Analysis view cannot be opened

Performance needs to be investigated.

This makes no difference for Lttng 2.6 in mi mode

This makes no difference for Lttng 2.6 in mi mode

This makes no difference for Lttng 2.6 in mi mode

Incorrect command-line was build (Bug 459444)



171

17.2

17.3

17.4

175

17.6

17.7

17.8

C witl

Create h
(LTTng 2.2 features)

Configure Metadata channel (kernel)

Configure Metadata channel (UST)

Configure File rotation (kernel)

Configure File rotation (ust)

Buffer Type - toggle UST/kernel

Default UST Buffer Type

per PID UST Buffer Type

LTTng 2.0 - Control

For the tests below a Ubuntu machine with LTTng 2.1 installed
(with Ittng tools 2.1.x) is required. Either create a VM machine
yourself (e.g. on Virtualbox) or install it locally on your native
Ubuntu (if correct version). Make sure that the root session
daemon is running (sudo lttng list -k) and have one UST
process running (e.g. from Ittng-tools git repository under
tests/hello.cxx).

Verify after 3) that 'Channel Name' is set to metadata
and the correspondig textbox is disabled. Verify after 5)
that metadata channel was created under the kernel
domain. Also verify in the properties view that all
parameters are set correctly when selecting the channel
metadata.

1) Create and select session and click right mouse button
2) Select menu item 'Enable Channel..."

3) Select Checkbox 'Configure metadata channel'

4) Update all text boxes

5) Click on 'Ok’

Verify after 3) that 'Channel Name' is set to metadata
and the correspondig textbox is disabled. Verify after 5)
that metadata channel was created under the domain
UST global. Also verify in the properties view that all
parameters are set correctly when selecting the channel

1) Re-do 17.2 with a UST channel metadata.

1) Create and select session and click right mouse button
2) Select menu item 'Enable Channel..."
3) Fill in channel name

4) Fill in 1048576 in 'Maximum size of trace files' and also 'Sub
Buffer Size'

5) Fill in 2 in 'Maximum number of trace filesfiles'

6) Click on 'Ok’

7) Enable all kernel events

8) Start, wait and stop tracing.

After 8) verify on the trace node that trace files are not
bigger than 1048576 bytes

1) Create and select session and click right mouse button
2) Select menu item 'Enable Channel..."

3) Fill in channel name

4) Select UST

5) Fill in 262144 in 'Maximum size of trace files' and also 'Sub
Buffer Size'

6) Fill in 2 in 'Maximum number of trace filesfiles

7) Click on 'Ok’

8) Enable all UST events

9) Start, wait and stop tracing.

After 9) verify on the trace node that trace files are not
bigger than 262144 bytes

1) Create and select session and click right mouse button Verify after 2 and 4 that the radio buttons for the buffer

2) Select menu item 'Enable Channel...' type is disabled and the buffer type "Global shared

3) Select UST buffers" is selected which is the value for the kernel

4) Select Kernel tracer.

5) Slect cancel Verify after 3) that the radio buttons are enabled an no
buffer type is selected

1) Create and select session and click right mouse button

2) Select menu item 'Enable Channel...'

3) Select UST Verify after 5) that the default buffer type is configured

4) Enter Channel Name for that channel (see properties view). Note for LTTng

5) Select 'Ok’ Tools 2.2 the default is per-PID and for LTTng Tools 2.3

and later it is per-UID

Prequisite: Multiple UST Applications need to run

1) Create and select session and click right mouse button
2) Select menu item 'Enable Channel...'
3) Select UST

4) Select 'Per PID buffers'

5) Enter Channel Name

6) Select 'Ok’

8) Enable all ust events

9) Start, wait and stop tracing.

10) Import trace

Verify after 6) that the per-pid buffer type is configured
for that channel (see properties view). After 10) make
sure that for each UST application one trace is created
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Command is successful. However tracer doesn't create

Manual metadata channel

Manual Kernel trace is generated corretly with LTTng 2.5.4
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Manual

Manual



17.9

18.1
18.2

18.3

18.4

18.5
18.6
18.7

18.8

18.9

18.10

18.11

19.1

per UID UST Buffer Type

Snapshot Channel (LTTng 2.3
features)

Preparation

Create Snapshot Session
Enable Kernel Event

Start Session

Record snapshot

Create another snapshot session
Enable UST Events
Start UST session

Record snapshot over multiple sessions

Import traces

Stop and destroy sessions

Network snapshot session

Command Script

Execute command sript

LTTng 2.0 - Control

Prequisite: Multiple UST Applications need to run

1) Create and select session and click right mouse button
2) Select menu item 'Enable Channel...'

3) Select UST

4) Select 'Per UID buffers'

5) Enter Channel Name

6) Select 'Ok’ Verify after 6) that the per-pid buffer type is configured
8) for that channel (see properties view). After 10) make

9) sure that only one trace is created even multiple UST

10! applications are running.

Enable all ust events
Start, wait and stop tracing.
) Import trace

Connect to a node with LTTng 2.3 installed

Verify that new session is added under the Session tree
node. Verify properties in Properties view (by selecting
the session in the Control view):

'Session name' (=MySession)

'Snaphshot ID'
'Snapshot Name' (=snapshot-1)

'Session Path’' (=lhome/<user>/traces/MySession_<date
and time>) and 'State' (<INACTIVE)

1) Click right mouse button on 'Sessions'

2) Select ‘Create Session..." in the context sensitive menu

3) Enter session name 'MySession', keep 'Session Path' empty
4) Select checkbox 'Snapshot Mode'

5) Select 'Ok’

Enable all Kernel Tracepoint and syscall events

Make sure that the button and menu item 'Record
Snapshot' is disabled

Verify that channel and events a successful enabled

Verify that Session icon changes to 'ACTIVE' icon. Verify
that property view shows 'ACTIVE' for the session state

Make sure that the button and menu item '‘Record
Snapshot' is enabled. Also make sure that the Button
and menu item 'Import’ is enabled.

a) Select session and click on button 'Start'
b) Redo test with context sensitive menu item 'Start'

select session and record 2 snapshots: Once with button
‘Record Snapshot' and once with context-sensitive menu item

‘Record Snapshot' Commands succeed without error

session name ustSession (as described in 18.1)
Enable all UST events
see 18.3

Select kernel and ust session (see 18.1 and 18.5) and click on
'Record snapshot' button

Make sure that snapshot session is created successfully
Verify that channel and events a successful enabled
see 18.3

Command succeeds without error

Verify that 4 snapshots are available (3 kernel and 1
UST). Verify that all snapshots are imported to the

Open Import dialog (see 11.2) selected tracing project

Stop and destroy both sessions

1) Sta;t relayd on Eclipse local machine (default settings: Ittng-
relayd

2) Open Create Session Dialog box, select 'Snapshot
Mode'and select "Advanced >>>"

3) Enter session name, select net protocol and enter IP
address of Eclipse local machine in address field and press ok
4) Enable events (UST and Kernel), start tracing, and recored
a few snapshots, stop tracin

5) Import traces to a existing tracing project

6) Destroy session

Verify that sessions are destroy successfully

Make sure that all steps were successfull. Also, import
the traces using the standard import instead of the
remote import

Create a command script to create a session with kernel and

Make sure that each command of script is executed and
ust events enabled.

script execution is without errors
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While doing this | found a few bugs but it ended up working. See
https://bugs.eclipse. /_bug.cgi?i an
https://bugs.eclipse.org/bugs/show_bug.cgi?id=469424

Ittng-consumerd crashed after a couple of snapshots but
everything worked on Trace Compass side



Section
GDB Tracing

Target: Ubuntu 15.04 64 bit

Step

1
1.1
1.2

N

2.1
2.2
2.3

w

3.1
3.2
33

E-Y

4.2
4.3

w

5.2

(-

6.2
6.3

~

71
7.2
73
7.4
7.5

Test Case

Preparation
Step 1
Step 2

Project Creation
New Project Wizard
Create project
Project structure

Traces Folder
Traces Folder menu
Trace Import Wizard
Import traces

Trace Configuration

Project/executable selection

Select Trace Executable
Open configured trace

Source Code Lookup
Select event

Select another event

Events Table Navigation

Arrow keys

Scrolling
PgUp/PgDn

Home/End

Events Searching & Filtering
Search

Navigation

Un-search

Filter

Un-filter

Pass

Action

Open and reset the GDB Trace perspective
Open Navigator View (used for independent verification)

Open New Tracing Project Wizard
Specify a project name and finish
Close and open the new Tracing project

Select the Traces folder and open its context menu
Select Import Trace
Select a GDB Trace from samples directory and finish

Double-click on an un-configured trace
1) Right mouse click on trace

2) Select menu item "Select Trace Executable"
3) Fill in the proper values in dialog and finish

Double-click on a configured trace

With mouse select an event in events table

redo 5.1

GDBTracing

Fail

Verification

GDB Trace perspective opens with correct views
Navigator View opens

Tracing Project Wizard opens
Tracing project appears in Project Explorer
Project contains the Traces folder

Correct menu opens (Open Trace, Import, New Folder, ...)
Trace Import Wizard appears
Imported traces appear in Folders with proper icon

Verify that an Error Dialog opens that notfiies the user to select
the trace executable

Trace is configured (4.3 is successful, when 4.2 was successful)
Trace is opened, events table and views are populated

The corresponding source code location is selected in the source
code file.

The corresponding source code location is selected in the source
code file.

Each keystroke modifies the selected event and the corresponding

Update the current event using up/down keys within window source code location is selected in the source code file.

Table is refreshed to display new current event and the
corresponding source code location is selected in the source code

Update the current event using up/down keys outside windo file

Update the current event using PgUp/PgDn keys

Update the current event using Home/End keys

In the search bar, enter some RE

Table is scrolled accordingly

Table jumps from first to last event and the corresponding source
code location is selected in the source code file

Events corresponding to the RE are highlighted

Navigate through highlighted events using Enter/Shift-Enter Next/previous highlighted event selected accordingly

In the search bar, clear the RE
In the Ffilter bar, enter some RE
Ithe filter bar, clear the RE

Events are displayed normally
Only events matching RE are displayed
Events are displayed normally
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To Do

Pass
Pass

Pass
Pass
Pass

Pass
Pass
Pass

Pass

Pass
Pass

Pass

Pass

Pass

Pass
Pass

Pass

Pass
Pass
Pass
Pass
Pass

Comment
0

Comment



7.6
7.7

8.1
8.2

Filter & Search
Search & Filter

Events Synchronization
Synch from Events View
Synch from Trace Control

In the Ffilter bar, enter some RE; likewise in the search bar
In the search bar, enter some RE; likewise in the filter bar

Click on an event in the Events View
Go up/down from the Trace Control View

GDBTracing

Events are filtered and highlighted accordingly
Events are filtered and highlighted accordingly

Trace Control View is updated; Debug View is updated
Events View is updated accordingly
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RCP

Section Pass Fail ToDo Comment

Target: Ubuntu 15.04

Step Test Case Action Verification Comment

1 Start RCP

1.1 Start Tracing RCP Open RCP from command line or file explorer Tracing RCP opens in default perspective Manual Pass
Start Tracing RCP with text Open RCP from command line with --open <trace name with
1.2 trace absolut path> Trace will be opened with auto-detected trace type Manual Pass
Start Tracing RCP with Open RCP from command line with --open <trace name with  Verify that the same trace that was previously linked into the
1.3 previously opened text trace absolut path>. Use same trace than 1.2 Traces folder is opened and not a new trace entry is created Manual Pass
Start Tracing RCP with Kernel Open RCP from command line with --open <kernel trace Tracing RCP is opened, the trace is linked to the Tracing project, The kernel trace opens in an editor but the editor of the first trace
1.4  CTFtrace name with absolut path> the kernel analysis trace type is selected and trace is opened. Manual Pass  gets activated. Bug 443461.
Start Tracing RCP with
previously opened Kernel CTF Open RCP from command line with --open <kernel trace Verify that the same trace that was previously linked into the
1.5 trace name with absolut path>. Use same trace than 1.4 Traces folder is opened and not a new trace entry is created Manual Pass

Open RCP from command line with --open <trace name with  Verify that a new trace is linked to the Tracing project and trace is
Start Tracing RCP with new  absolut path>, where the name of trace is the same than 1.2, opened. Verify that the new trace name has a integer number a
1.6 trace with name conflict but the trace is located at a different location on disk suffix added. Manual Pass

Open RCP from command line with --open <kernel trace with Verify that a kernel trace is linked to the Tracing project, the

absolut path>, where name of trace is the same than 1.4, but kernel analysis trace type is selected and trace is opened. Verify
1.7 Re-do 1.6 the trace is located at a different location on disk that the new trace name has a integer number a suffix added. Manual Pass

Start Tracing RCP with non-

1.8 trace file Open file that is not a trace Trace is imported (linked) however default icon (from Eclipse) is set  Manual Pass
2 File menu
Use Menu "File -> Open Trace ..." In the file dialog select a
2.1 Open Trace (File) text trace and select open. Trace will be opened with auto-detected trace type Manual Pass
Open Trace (File) with Use Menu "File -> Open Trace...". In the file dialog select a Verify that the same trace that was previously linked into the
2.2 previously opened text trace text trace and select open. Use same trace than 2.1 Traces folder is opened and not a new trace entry is created Manual Pass
Use "Menu File -> Open Trace ..." . In the file dialog selecta  Verify that the trace is linked to the Tracing project, the kernel
2.3 Open Trace (Directory) file of Kernel CTF trace directory and select open. analysis trace type is selected and trace is opened. Manual Pass
Open Trace (Directory) with  Use "Menu File -> Open Trace ..." . In the file dialog select a
previously opened Kernel CTF file of Kernel CTF trace directory and select open. Use same Verify that the same trace that was previously linked into the
2.4 trace trace than 2.3 Traces folder is opened and not a new trace entry is created Manual Pass

Use Menu "File -> Open Trace ..." In the file dialog select a
text trace and select open, where the name of trace is the Verify that the new trace is linked to the Tracing project and the
Open Trace File with name same than 2.1, but the trace is located at a different location trace is opened. Verify that the new trace name has a integer
2.5  conflict on disk number a suffix added. Manual Pass

Use "Menu File -> Open Trace ..." . In the file dialog select a
file of Kernel CTF trace directory and select open, where the Verify that the kernel trace is linked to the Tracing project, the

name of trace is the same than 2.3, but the trace is located at kernel analysis trace type is selected and trace is opened. Verify
2.6 Re-do 2.5 a different location on disk that the new trace name has a integer number a suffix added. Manual Pass

2.7  Openfile Open file that is not a trace Trace is imported (linked) however default icon (from Eclipse) is set  Manual Pass
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2.8
2.9

3.1

3.2
33

3.4

35

41

4.2

4.2

44

4.5

5.1

5.2

5.3
5.4

6.1

Restart

Exit

Window Menu
Open Perspective

Open View
Preferences

Save Perspective As

Reset Perspective

Help Menu

Help Contents

Help Contents (shortcut)
Install new Software
About

Version + Copyright
Content
TMF presence

LTTng presence
PCAP Network analysis
presence

BTF presence

Upgrade

Upgrade from previous
release

Use Menu File -> Restart
Use Menu File -> Exit

Use Menu Window -> Show Perspective -> Tracing

Perspective

Use Menu Window -> Show View -> Select Tracing ->

Sequence Diagram
Use Menu -> Preferences

Make changes of perspective by moving views and use menu
Wwindow -> Save Perspective As. Enter a perspective name

and select Ok

Make changes of perspective by moving views and use menu
Window -> Reset Perspective.

Use Menu -> Help -> Help Contents

Use key F1

Use Menu -> Help -> Install New Software... to install new

Eclipse feature

Use Menu -> Help -> About

Use Menu -> Help -> About -> Installation details

Open Tracing perspective

Open LTTng Kernel perspective

Open Network analysis perspective

Open BTF trace

Use Help -> Check For Updates

RCP

Verify that RCP is restarted with the previously open perspective

and trace
Tracing RCP exits

Tracing perspective is opened

Sequence diagram view is shown
Preferences dialog is shown

Perspective with new name is stored
After confirming the reset operation the perspective is reset to the

default layout.

Help content browser is opened. All Tracing related help is

included

Help content browser is opened. All Tracing related help is

included

Installation is successful

About dialog is opened all relevent information (e.g. version,
copyright years etc) is up-to-date and correct.

Go over all tracing features and plug-ins and verify that all have the
correct version and copyright years

Tracing perspective opens

LTTng Kernel perspective opens

Network analysis perspectiv opens

BTF trace opens correctly

RCP is upgraded
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Tested with RC1



Target:

0.1

0.2

0.3
0.4

21

2.2
23

24
25

2.6

3.1

Section

LTTng 2.0 - Memory
Analysis

Ubuntu 14.04 64 bit
Test Case

Prerequisites

Download traces

Import trace with memory
event

Import trace without
memory event

Import non-UST trace

Project View

Check analysis can
execute

Verify help message when
applicable

Check analysis cannot
execute

Verify help message when
not applicable

Check analysis for another
trace type

View Management

Populate analysis's view

Open view
Close trace

Open trace
Close view

Re-open view
Mouse handling

Drag move time range

LTTng 2.0 - Memory analysis

Action

Download UST trace with memory events
from

http://secretaire.dorsal.polymtl.ca/~gbastien

/traces/eclipse_mem_ust.tar.gz

Import the LTTng UST trace downloaded
above in Tracing project

Import one of the LTTng UST trace that
does not contain the memory events, for
example, the one used for the callstack
view

Import one LTTng Kernel trace

In the project explorer, expand the trace
that contains the memory events

In the project explorer, open and expand
the trace that contains the memory events,
right-click the memory analysis and select
Help

In the project explorer, expand the UST
trace that does not contain memory events
In the project explorer, open and expand
the UST trace that does not contain
memory events, right-click the memory
analysis and select Help

In the project explorer, expand a LTTng
Kernel trace

Open the UST trace with memory events
and expand the "UST Memory" analysis in
the project explorer

Double-click the UST Memory View under
the memory analysis

Close the trace

With the view already opened, open the
trace

Close the UST Memory Usage view

Double-click the UST Memory Usage view
under the memory analysis in project
explorer.

Drag move xy chart left and right with
middle button

Verification

Note: Traces generated with LTTng 2.7 and later won't populate the view
because the libc tracepoint names were changed.
https://bugs.eclipse.org/bugs/show_bug.cgi?id=470186

"Ust Memory" analysis is present and "normal"

A generic help message appears with the name of the
analysis.

"Ust Memory" analysis is present, but striked-out

The help message mentions the analysis is impossible to
execute and contains the requirement that is not fulfilled

"Ust Memory" analysis is not present

"Ust Memory Usage" View appears under the analysis

The UST Memory Usage view opens and triggers the memory
analysis. After the analysis, the XY chart is populated

The UST Memory Usage view is emptied.

The UST Memory Usage view is populated.
The view is closed.

The view opens and is automatically populated.

Time range is dragged. When mouse button is released, the
view refreshes with the new time range
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Comment
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View not populated. Bug 467751

But while dragging, nothing visible happen



3.2

3.3
34

3.5

3.6

3.7

3.8

4.1

4.2

4.3

Zoom time range (mouse
wheel) cursor inside xy chart

Drag select time range

Mouse hover Hover mouse in xy chart anywhere

Drag mouse selection Drag select xy chart with left button

Click select with left button (begin time),

Zoom with mouse wheel up and down,

Drag select time graph with right button

LTTng 2.0 - Memory analysis

Time range is zoomed in and out, relative to mouse cursor.
When mouse wheel is stopped for a short time, series are
updated and new time range is propagated to other views.
Selection highlighted. When mouse button is released, time
range is zoomed to selection, series are updated and new time
range is propagated to other views.

Tool tip shows values for each thread at the given timestamp

Selection highlighted. New selection is propagated to other
views

press shift key and click select another time Selection highlighted. New selection is propagated to other

Shift key selection (end time)

Drag mouse selection

(Status bar) Drag select xy chart with left button

Click select with left button (begin time),

views

Selection highlighted. Status bar of Eclipse is updated with
time information: T, T1, T2 and delta, where T is the time of the
mouse position, T1 the left most selected time, T2 the right
most selected time and delta the time difference between T2-
T1

Selection highlighted. Status bar of Eclipse is updated with
time information: T, T1, T2 and delta, where T is the time of the
mouse position, T1 the left most selected time, T2 the right

Shift key selection (Status press shift key and click select another time most selected time and delta the time difference between T2-

bar) (end time)
Synchronization

Have the Histogram and UST Memory

Preparation Usage views both visible

Time synchronization Select a random time in another view

Select a new time range in UST Memory

Time range synchronization Usage view or in Histogram view.

Time range selection

synchronisation synchronization, select a new range.

In any other view that supports range

Selected time line is updated. If selected time is outside current
range, time range is updated to include it.

Time range is updated.

Selection is highlighted. If begin time (T1) of selected time
range is outside the current range, then time range is
updated to include it
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Second click-select just select the timestamp,
no range

Status bar is not updated. Note that the status
bar hasn't been implemented for XY charts. So
N/A we should not test for it

N/A Status bar not updated

Clicking outside range does not work

View does not include T1 outside current range



LTTng 2.0 - CPU analysis

Section Type ToDo Comment

LTTng 2.0 - CPU Analysis n“
Target:
Step Test Case Action Verification Type Comment
0 Prerequisites
0.1 Import traces Import LTTng Kernel traces in Tracing project
1 Project View
Check analysis can In the project explorer, expand a LTTng
1.1 execute Kernel trace "CPU usage" analysis is present and "normal" Manual Pass

In the project explorer, open and expand the
Verify help message when LTTng kernel trace, right-click the CPU usage A generic help message appears with the name of the

1.2 applicable analysis and select Help analysis Manual Pass
Check analysis for another In the project explorer, expand a non-LTTng

15 trace type Kernel trace "CPU usage" analysis is not present Manual Pass

2 View Management

Open an LTTng kernel trace and expand the
21 Populate analysis's view  "CPU usage" analysis in the project explorer "CPU Usage" View appears under the analysis Manual Pass
The CPU usage Usage view opens and triggers the cpu
Double-click the CPU usage View under the  analysis. After the analysis, both tree viewer and xy charts

22 Open view CPU usage analysis are populated. Manual Pass
23 Close trace Close the trace The CPU Usage view is emptied. Manual Pass
24 Open trace With the view already opened, open the trace The CPU Usage view is populated. Manual Pass
25 Close view Close the CPU Usage view The view is closed. Manual Pass
Double-click the CPU Usage view under the
2.6 Re-open view CPU usage analysis in project explorer. The view opens and is automatically populated. Manual Pass
3 View selection
A new series is added to the xy chart, corresponding to the
3.1 Select an entry Select an entry in the tree viewer section selected TID Manual Pass
A new series is added to the xy chart, and the previous TID's
3.2 Select another entry Select another entry from the tree viewer series is not displayed anymore Manual Pass
4 Mouse handling

Time range is dragged. When mouse button is released,
Drag move xy chart left and right with middle  series are updated and new time range is propagated to
4.1 Drag move time range button other views. Manual Pass But while dragging, nothing visible happens

Time range is zoomed in and out, relative to mouse cursor.
When mouse wheel is stopped for a short time, series are
updated and new time range is propagated to other views,
Zoom time range (mouse  Zoom with mouse wheel up and down, cursor including the tree viewer beside the chart. The selected
4.2 wheel) inside xy chart process remains the same. Manual Pass

Scroll with mouse wheel up and down, cursor Table scroll up and down. Selected process does not
4.3 Mouse vertical scroll outside xy chart change. Vertical scroll bar updated. Manual Pass

Tree viewer scrolls up and down. Selected process does not
4.4 Vertical scroll bar Click and drag vertical scroll bar change. Manual Pass

Selection highlighted. When mouse button is released, time
range is zoomed to selection, series are updated and new
Drag select time graph with right button in xy time range is propagated to other views. Selected process
rt

4.5 Drag select time range remains the same. Manual Pass
Tool tip shows the total and selected process (if any) cpu It would be nice to display the process name

4.6 Mouse hover Hover mouse in xy chart region anywhere usage at the time Manual Pass instead of the tid. It would also be nice to crop the percentage
Selection highlighted and selection rang is propagated to

4.7 Drag mouse selection Drag select xy chart with left button other views Manual Pass
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4.8

4.9

4.10

4.1

5.1

6.1

6.2

6.3

Click select with left button (begin time), press
shift key and click select another time (end
Shift key selection time)

Sort columns Click on column headers once then twice

Drag mouse selection
(Status bar) Drag select xy chart with left button

Click select with left button (begin time), press
Shift key selection (Status  shift key and click select another time (end
ar) time)

Keyboard handling

Keyboard navigation in tree With focus on table, use UP, DOWN, HOME,

viewer END keys
Synchronization
Time synchronization Select a random time in another view

Select a new time range in CPU usage view or
Time range synchronization in Histogram view.

Time range selection In any other view that supports range
synchronisation synchronization, select a new range.
CPU usage works with

experiments

LTTng 2.0 - CPU analysis

Selection highlighted and selection rang is propagated to
other views

Entries are sorted in ascending then descending order on
the column value. Selected process does not change.

Selection highlighted. Status bar of Eclipse is updated with
time information: T, T1, T2 and delta, where T is the time of
the mouse position, T1 the left most selected time, T2 the
right most selected time and delta the time difference
between T2-T1

Selection highlighted. Status bar of Eclipse is updated with
time information: T, T1, T2 and delta, where T is the time of
the mouse position, T1 the left most selected time, T2 the
right most selected time and delta the time difference
between T2-T1

Selected process is changed. xy chart selection is updated.
Vertical scroll bar updated.

Selected time line is updated. If selected time is outside
current range, time range is updated to include it.

Time range is updated.

Selection is highlighted. If begin time (T1) of selected time
range is outside the current range, then time range is
updated to include it
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Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

N/A

N/A

Status bar is not updated. Note that the status
bar hasn't been implemented for XY charts.
So we should not test for it

Status bar not updated

No update if selected time outside current
range

xy chart range does not include T1 ouside
current range



Target:

Step

0

0.1
0.2
0.3

1.6

1.6.5
1.7

1.8

Section
Trace Synchronization

Test Case

Prerequisites

Import traces
Create experiment 1
Create experiment 2

View Management

Open Synchronization
View

Delete view
Open view

Open Experiment

Synchronize experiment

Open view when trace is
already loaded

Synchronize experiment
with constant offset

Open trace
Re-open experiment

Restart
Functionnalities
Open experiment 2
Go back to previous
experiment

Synchronize experiment

TraceSynchronization

Pass

Action

Import the scp_dest and scp_src traces in the
synctraces.tar.gz file

Create an experiment containing those 2 traces
Create an experiment with any other trace

Use menu Window - Show View - Other ... »
Tracing - Synchronization
Close the Synchronization View

Use menu Window — Show View - Other ... >
Tracing - Synchronization

Open the experiment containing the 2
synchronizable traces

Right-click on the experiment and select
'Synchronize experiment'

1) Close Synchronization View
2) Load LTTng experiment
3) Open 'Synchronization' view

Try to offset a trace by a second

Open an Lttng Kernel trace

Open the experiment containing the 2
synchronized traces

Restart Eclipse

Open the experiment containing traces that do not
synchronize

Re-open the experiment with the synchronizable
traces

Right-click on the experiment and select
'Synchronize traces'

Fail

Verification

Verify that 'Synchronization' view is shown
Synchronization' view is removed from perspective

Synchronization' view is displayed and remains empty

Verify that the view is still empty

After a time, the view is populated with synchronization
result that say 'accurate’. And one of the original traces
has been replace by a trace with the same name, but
with an'_' at the end.

Verify that view is populated with synchronization data
from currently opened experiment

Visually verify that a synchronized trace is now
offsetted

Synchronization view is empty

View shows synchronization data from the experiment

Verify that view is populated with synchronization data
from experiment

Verify that the 'Synchronization' view is empty

Verify that the 'Synchronization’ view contains the data
from the experiment

After a time, the view is populated and the
synchronization quality says 'Absent’
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To Do
0 0

Manual Pass
Manual Pass
Manual Pass
Manual Pass
Manual Pass
Manual Pass
Manual Pass
Manual Pass
Manual Pass
Manual Pass
Manual Pass
Manual Pass
Manual

Comment
4

Comment

This view should be in properties

The view also makes no sense to mere mortals.

Absent is not displayed, view is empty



XMLanalysis

Section Comment
XML analysis

Target: Ubuntu 14.04 64 bit

Type To Do

Test Case Action Verification Comment

0 Prerequisites

0.1 Import traces Import LTTng kernel traces
Download the test XML file here:
http://secretaire.dorsal.polymtl.ca/~gbastien/Xml4Tra
0.2 Get a test XML file ces/Kernel.Linux.xml
The XML files are located in <workspace
directory>/.metadata/.plugins/org.eclipse.tracecompas
Make sure the XML file does s.tmf.analysis.xml.core/xml_files. Delete the linux NOTE: XML haven't files haven't been update to latest Kernel tracepoints

0.3 not exists in the project kernel XML file if it exists. and syscall changes. So, they only work with trace LTTng 2.5 and older
1 XML file import
In the project Explorer, expand any LTTng kernel
1.1 Verify analysis not present  trace Verify that there is no 'Xml kernel State System' analysis Manual Pass
Right-click the Traces folder, select Import XML Verify that the 'Xml kernel State System' analysis is now present
1.2 Import XML file analysis and select the Kernel.Linux.xml file under a LTTng kernel trace Manual Pass
2 View management

The "Xml kernel State System' analysis should have a + next to
it, expand it and there should be 2 views under it: 'Xml Control

2.1 Populate the views Open an LTTng kernel trace Flow View' and 'Xml Resources View' Manual Pass
Open the 'Xml Control Flow Double-click the 'Xml Control Flow View' under the A view titled 'Xml Control Flow View' should open and it
22 View' analysis should look quite similar to the Control Flow View Manual Pass
The new view replaces the "Xml Control Flow View' and the
Double-click the "Xml Resources View' under the title changes to "Xml Resources View'. This view is quite similar
23 Open another XML view analysis to the Resources view's CPU entries. Manual Pass
24 Close view Close the XML view The view is closed Manual Pass
Open view when trace is
2.5 already loaded Double-click one of the views under the analysis The view opens with the correct title and is correctly populated.  Manual Pass
2.6 Close traces Close all opened traces The view is emptied. Manual Pass
2.7 Open trace Open an LTTng Kernel trace The view is populated Manual Pass
2.8 Open another trace Open a non-LTTng Kernel trace The view is emptied. Manual Pass
29 Open LTTng Kernel trace Open an LTTng Kernel trace The view is populated. Manual Pass
3 View selection
3.1 Select an entry in the table Select an entry in the table Same entry is highlighted in time graph. Manual Pass

Same entry is highlighted in table. Selected time line is updated.
3.1 Select entry in time graph Select an entry in the time graph (empty region) Other views are synchronized to selected time. Manual Pass

Same entry is highlighted in table. State is highlighted in time
graph. Selected time line is updated. Other views are

2.3 Select state in time graph Select a state in the time graph synchronized to selected time. Manual Pass
4 Mouse handling
Drag move time graph left and right with middle Time range is dragged. When mouse button is released, states
4.1 Drag move time range button are updated and new time range is propagated to other views. Manual Pass

Time range is zoomed in and out, relative to mouse cursor.
Zoom time range (mouse Zoom with mouse wheel up and down, cursor inside When mouse wheel is stopped for a short time, states are
4.2 wheel) time graph updated and new time range is propagated to other views. Manual Pass
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Time range is zoomed in and out. When mouse button is
Zoom time range (mouse released, states are updated and new time range is propagated to
43 drag) Drag in time graph scale left and right with left button other views. Manual

Scroll with mouse wheel up and down, cursor outside Table and time graph scroll up and down and remain aligned.
4.4 Mouse vertical scroll time graph Selected entry does not change. Vertical scroll bar updated. Manual

Table and time graph scroll up and down and remain aligned.
4.5 Vertical scroll bar Click and drag vertical scroll bar Selected entry does not change. Manual

Selection highlighted. When mouse button is released, time
range is zoomed to selection, states are updated and new time
4.6 Drag select time range Drag select time graph with right button range is propagated to other views. Manual

Time range is reset to full range, states are updated and new
4.7 Double-click reset time range Double-click left button on time scale time range is propagated to other views. Manual

4.8 Mouse hover (empty region) Hover mouse in time graph over empty region Tool tip shows entry name only. Manual

Tool tip shows entry name, state name, date, start time, end
49 Mouse hover (state) Hover mouse in time graph over state time, duration. Manual

Selection highlighted. Status bar of Eclipse is updated with time
information: T, T1, T2 and delta, where T is the time of the
mouse position, T1 the left most selected time, T2 the right most

4.10 Drag mouse seleection Drag select time graph with left button selected time and delta the time difference between T2-T1 Manual

Selection highlighted. Status bar of Eclipse is updated with time
information: T, T1, T2 and delta, where T is the time of the
Click select with left button (begin time), press shift mouse position, T1 the left most selected time, T2 the right most
4.11 Shift key selection key and click select another time (end time) selected time and delta the time difference between T2-T1 Manual

5 Keyboard handling

Keyboard navigation in table With focus on table, use UP, DOWN, HOME, END  Selected process is changed. Time graph selection is updated.
5.1 (entry selection) keys Vertical scroll bar updated. Manual

With focus on table,
in Windows use LEFT, RIGHT keys while parent or
child process is selected For parent process, tree is expanded or collapsed. Time graph
item expansion is updated. Vertical scroll bar updated. For child
Keyboard navigation in table in Linux use SHIFT LEFT, RIGHT keys while parent process, left changes selection to parent, time graph selection is
52 (tree expansion) or child process is selected updated. Vertical scroll bar updated. Manual

Keyboard navigation in time ~ With focus on time graph, use UP, DOWN, HOME,  Selected process is changed. Table selection is updated. Vertical

54 graph (process selection) END keys scroll bar updated. Manual
Keyboard navigation in time Previous or next state is selected. Selected time is updated in
54 graph (state selection) With focus on time graph, use LEFT, RIGHT keys  other views. Manual
6 Tool bar handling
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6.1

6.2

6.3

6.4

6.5
6.6

6.7

7.1

72

7.3

Show Legend

Reset Time Scale
Select Previous/Next Event

Select Previous/Next Process

Zoom In/Out
Filter Dialog

Filter Processes

Synchronization

Time synchronization

Time range synchronization

Time range selection
synchronisation

Click Show Legend button

Click Reset Time Scale button
Click Previous/Next Event button

Click Previous/Next Process button

Click Zoom In/Out button
Open Filter Dialog
1) Open Filter Dialog

2) Deselect several processes
3) Press Ok

Select a random time in another view

Select a new time range in Resources view or in
Histogram view.

In any other view that supports range synchronization,
select a new range.

XMLanalysis

The legend dialog is opened and can be closed.

Time range is reset to full range, states are updated and new
time range is propagated to other views.

Previous or next state is selected. Selected time is updated in
other views.

Selected process is changed in table and time graph. Vertical
scroll bar updated.

Time range is zoomed in and out, relative to center of time
range. States are updated and new time range is propagated to
other views.

Verify that all buttons are working correctly

Verify that only selected entries are displayed in the view
Selected time line is updated. If selected time is outside current
range, time range is updated to include it.

Time range is updated.

Selection is highlighted. If begin time (T1) of selected time
range is outside the current range, then time range is updated to
include it
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Manual

Manual

Manual

Manual

Manual
Manual

Manual

Manual

Manual

Manual

Comment from 1.0 testing: Not all
displayed colors are in the legend

This is still a problem in 1.1 when using
traces generated with LTTng 2.6 and older

More filter buttons are available in cfv

With T1 outside current range, the time range is not updated to include it.




Target:

Step

0
0.1
1

1.1

1.2

2.2
2.3
2.4

2.5
2.6

Section
Network Trace analysis

Test Case

Prerequisites
Import traces
Trace Import

Pass

Network Analysis

Fail

Action

Import the trace linked here

Open the Network Tracing In the project Explorer, expand any LTTng

perspective

Open trace
View management
Populate the views

Look up stream
Close the trace

Close view

Open view when trace is
already loaded

Open a non pcap trace
Stream List
Re-open trace

Create a filter from the
stream list

Apply filter

kernel trace

Verification

Verify that the events view, the properties and
stream list are displayed

The trace is given a "network" icon. When
openned, the events view and histogram view is

Double-click on the "TeamSpeak2.pcap" trace opened

Open the "TeamSpeak2.pcap”

Open the Stream list
The stream list is emptied
Close the view

Re-open the trace. Open The Stream List
The stream list is emptied

Ensure only "TeamSpeak2.pcap" is opened

The views are updated

One stream is available with endpoint A being
Fe:FF:FF:FF:FF:FF

The view is closed

The view opens with the correct title and is
correctly populated.

The trace is opened

A filter named "FILTER stream eth 00:0c:29..." is

Right click on stream 0, and select "create filter" created

In the events table, right click on an event and
select "Apply preset filter->00:0c:29..."

24/24 events pass the filter
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To Do
3 0
SWTBot Pass
SWTBot Pass
SWTBot Pass
Manual Pass
Manual Pass
Manual Pass
Manual Pass
Manual Pass
Manual Pass
Manual Pass
Manual Pass

Comment
0

Comment

In SWTBot other trace is used

| see a different stream, wireshark confirms the e
BTW, SWTBot tests exist to open view but with no


http://wiki.wireshark.org/SampleCaptures?action=AttachFile&do=get&target=TeamSpeak2.pcap

Bug Reports

Section # Bug Reports # Open # Fixed
Bug Reports 21 15 6
Test Case Bug Title Bug Report Status
Project view Import to experiment will swallow exceptions  https://bugs.eclipse.org/bugs/show_bug.cgi?id=476475 Open

[TMF] Sequence Diagram Overview feature
Sequence Diagram 5.23 not working well on recent platform versions  https://bugs.eclipse.org/bugs/show_bug.cgi?id=436442 Open

LTTng 2 - Memory
Analysis 3.7, 3.8, CPU [TMF] Status bar is not updated when

Analysis 4.10, 4.11 selecting time range in XY charts https://bugs.eclipse.org/bugs/show_bug.cgi?id=436853 Open Enhancement

LTTng 2 - Memory

Analysis 4.1, CPU [TMF] Time selection outside current range

Analysis 6.1 should update current range in xy charts https://bugs.eclipse.org/bugs/show_bug.cgi?id=436861 Open

LTTng 2 - Memory

Analysis 4.3, CPU [TMF] Time range selection outside current

Analysis 6.3, range should update current range in time

XmlAnalysis 7.3 graph views https://bugs.eclipse.org/bugs/show_bug.cgi?id=436855 Open
[lttng rcp] Opening a second trace with --open

RCP 1.4 activates the wrong editor https://bugs.eclipse.org/bugs/show_bug.cgi?id=443461 Open
[TMF] Original experiment reappears after

Project View 6.5 rename and copy https://bugs.eclipse.org/bugs/show_bug.cgi?id=436888 Open
Sequence diagram interaction tooltip is hard

Sequence Diagram 3.1 to read on Ubuntu https://bugs.eclipse.org/bugs/show_bug.cgi?id=455523 Open
Button gets disabled in print dialog of

Sequence Diagram 5.24 sequence diagram after clicking on it https://bugs.eclipse.org/bugs/show_bug.cgi?id=455546 Open

Control view 17.9 NPE trying to destroy a session https://bugs.eclipse.org/bugs/show_bug.cgi?id=469424 Open
SWTEXxception widget is disposed trying to

Control view 17.9 import trace from Control view https://bugs.eclipse.org/bugs/show_bug.cgi?id=469425 Open

Resources view 6.1 and Time range synchronization problem in time

Control Flow view 6.1 graph https://bugs.eclipse.org/bugs/show_bug.cgi?id=476148 |Fixed
UST Memory analysis not working with LTTng

Memory analysis (all) 2.7 https://bugs.eclipse.org/bugs/show_bug.cgi?id=470186 Open
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Memory analysis 2.4/
CPU Analysis

Memory Analysis 3.6 /
CPU Analysis 4.8
Custom Parser 2.1

LTTng 2.0 -
ControlFlowView 2.1

LTTng 2.0 -
ControlFlowView 2.1

Time Chart 2.3

Time Chart 2.3

LTTng 2.0 Control Flow
view 8.2

LTTng 2.0 Control Flow
view 8.3

[TMF] XY chart view is cleared after being
filled when restarting or opening a trace

- [TMF] XY charts don't support SHIFT + Left
Mouse click to update the selection window
[GTK3] New Custom Parser dialog is very tall

lllegalArgumentException querying while
building

Incorrect birth times in Control Flow view

IOException in FlatArray.insert

Range of view is not the full range of the
traces.

[TMF] AbstractTimeGraphView sets wrong
bounds for unsupported trace

[TMF] Time graph fails to send window range
notification

Bug Reports

https://bugs.eclipse.org/bugs/show_bug.cgi?id=467751 Open

https://bugs.eclipse.org/bugs/show_bug.cgi?id=476390 Open

https://bugs.eclipse.org/bugs/show_bug.cgi?id=476471 Open

https://bugs.eclipse.org/bugs/show_bug.cgi?id=476474

https://bugs.eclipse.org/bugs/show_bug.cgi?id=476481

https://bugs.eclipse.org/bugs/show_bug.cgi?id=476487 Open

https://bugs.eclipse.org/bugs/show_bug.cgi?id=476816

https://bugs.eclipse.org/bugs/show_bug.cgi?id=477009

https://bugs.eclipse.org/bugs/show_bug.cgi?id=477012
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